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EEDDIITTOORRIIAALL

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE!

Another month, another issue. The usual LibreOffice and Python HowTo's are there,
and are joined by a HowTo on storing your data using SQLite. Ubuntu Games has a

bit of a Steam theme this month. First there's some game news from Dougn – mostly
with games given the Steam green light. Then, new writer Jonathan writes about his
joy, and discovery, of Valve's Steam. Joseph, another new writer, gives a review of (the
non-Steam related) Aeon Command.

I'd like to thank everyone who took the time to fill in last month's survey. This
month, I present the results of the survey from the 1,000 responses that we got. I can't
guarantee we'll cover everything you request, but I'll do my best. Again, I can publish
only what you folks send in. Also, while I'd love to cover scientific/HAM/other
software/uses - none of us are scientists/HAM folks, so we rely on readers in a
particular field/industry to submit reviews/stories.

Speaking of submissions - have you upgraded your *buntu to 13.04? How did it go?
Was it flawless? Were there a few little glitches? Or did it all go south? Write in and let
us know. Whether it's Ubuntu, Kubuntu, Lubuntu, or Xubuntu, we want to know. Same
for derivatives like Mint and such like.

All the best, and keep in touch!
Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

http://fullcirclemagazine.org

mailto:ronnie@fullcirclemagazine.org
http://www.scribus.net
http://www.gimp.org
http://www.libreoffice.org
http://creativecommons.org/
http://fullcirclemagazine.org
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UUBBUUNNTTUU NNEEWWSS
Written by The Ubuntu News Team

COMMUNITY ON

UBUNTU.COM

Daniel Holbach addresses
concerns as related to the

removal of the “community” link
from the navigation bar of
ubuntu.com. He shares details
related to the new community
website in progress and invites
everyone to help so it can be
launched, saying that it’s “very
likely just going to be a set of small
tasks, so any help would be much
appreciated.”
http://daniel.holba.ch/blog/2013/0
4/community-on-ubuntu-dot-com/

TESTING UBUNTU TOUCH

IMAGES (NOW WITH RARING!)

Nicholas Skaggs announces the
availability of Ubuntu Touch

images in the ISO QA Tracker and
encourages everyone to test out
the images for the 4 devices
available.
http://www.theorangenotebook.c
om/2013/04/testing-ubunutu-
touch-images-now-with.html

UBUNTU 13.04 (RARING

RINGTAIL) RELEASED

Adam Conrad, member of the
Ubuntu Release Team,

announces the release of Ubuntu
13.04 Raring Ringtail. This release
highlights daily quality, and
performance improvements, as
well as scaling capabilities on
Server. More information on those
highlights can be found at:
http://www.canonical.com/content
/ubuntu-1304-brings-dramatic-
graphical-performance-
enhancements
http://www.canonical.com/content
/ubuntu-1304-delivers-openstack-
high-availability-scalable-storage-
and-big-data-deployment-ca

In this email to the ubuntu-
announce mailing list, Conrad
notes that the following flavors
also announced their releases as
well.
Kubuntu:
http://www.kubuntu.org/news/kub
untu-13.04
Xubuntu:
http://xubuntu.org/news/13-04-
release/

Edubuntu:
http://edubuntu.org/news/13.04-
release
Lubuntu:
http://wiki.ubuntu.com/Lubuntu/A
nnouncement/13.04
Ubuntu Studio:
http://ubuntustudio.org/?p=726

In this announcement, Conrad
also welcomed two new flavors to
the Ubuntu archive--Ubuntu
GNOME and UbuntuKylin.
Ubuntu GNOME:
https://wiki.ubuntu.com/UbuntuG
NOME
UbuntuKylin:
https://wiki.ubuntu.com/UbuntuKy
lin

https://lists.ubuntu.com/archives/u
buntu-announce/2013-
April/000171.html

NOT SUPERCALIFRAGILISTIC-
EXPIALIDOCIOUS

SCORPIONFISH.

Mark Shuttleworth
congratulates the entire

extended Ubuntu community for
the 13.04 release and reveals the

codename for the next Ubuntu
release: Saucy Salamander. “The
salamander is one of nature’s most
magical creatures; they are a
strong indicator of a pristine
environment, which is a fitting way
to describe the new world
emerging around Ubuntu Touch.
[...] And we’re saucy too – life’s too
short to be stodgy or stilted”,
states Shuttleworth.
http://www.markshuttleworth.com
/archives/1252

PABLO RUBIANES AND

MARCOS COSTALES

APPOINTED TO THE LOCO

COUNCIL

Sergio Meneses announces the
newly appointed LoCo Council

members--Pablo Rubianes and
Marcos Costales. Meneses thanks
all nominees and notes they had
great applicants from which to
choose as always.
http://lococouncil.ubuntu.com/201
3/04/26/pablo-rubianes-and-
marcos-costales-appointed-to-the-
lococouncil/

http://daniel.holba.ch/blog/2013/04/community-on-ubuntu-dot-com/
http://www.theorangenotebook.com/2013/04/testing-ubunutu-touch-images-now-with.html
http://www.canonical.com/content/ubuntu-1304-brings-dramatic-graphical-performance-enhancements
http://www.canonical.com/content/ubuntu-1304-delivers-openstack-high-availability-scalable-storage-and-big-data-deployment-ca
http://www.kubuntu.org/news/kubuntu-13.04
http://xubuntu.org/news/13-04-release/
http://edubuntu.org/news/13.04-release
http://wiki.ubuntu.com/Lubuntu/Announcement/13.04
http://ubuntustudio.org/?p=726
https://wiki.ubuntu.com/UbuntuGNOME
https://wiki.ubuntu.com/UbuntuKylin
https://lists.ubuntu.com/archives/ubuntu-announce/2013-April/000171.html
http://www.markshuttleworth.com/archives/1252
http://lococouncil.ubuntu.com/2013/04/26/pablo-rubianes-and-marcos-costales-appointed-to-the-lococouncil/
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UBUNTU NEWS

UBUNTU 8.04 (HARDY

HERON), 10.04 (LUCID

LYNX) DESKTOP, AND 11.10
(ONEIRIC OCELOT) END OF

LIFE REACHED ON MAY 9,
2013

Adam Conrad, from the Ubuntu
Release Team, announces the

end of life of Ubuntu 8.04, the
desktop version of 10.04, and
11.10. He also provides the
upgrade paths and instructions for
upgrading.

http://fridge.ubuntu.com/2013/05/
10/ubuntu-8-04-hardy-heron-end-
of-life-reached-on-may-9-2013/

http://fridge.ubuntu.com/2013/05/
10/ubuntu-10-04-lucid-lynx-
desktop-end-of-life-reached-on-
may-9-2013/

http://fridge.ubuntu.com/2013/05/
10/ubuntu-11-10-oneiric-ocelot-
end-of-life-reached-on-may-9-
2013/

VIRTUAL UBUNTU

DEVELOPER SUMMIT 13.05

Chris Johnston reminds the
community to participate in

the next virtual Ubuntu Developer
Summit starting on May 14th. He
highlights the various tracks and
track leads and participants.
Johnston also lists some of the bug
fixes which have landed on the
latest summit portal. He invites
everyone to keep reporting
problems so the portal keeps
improving and leading to a better
vUDS.
http://www.chrisjohnston.org/ubu
ntu/virtual-ubuntu-developer-
summit-13-05

OUR COMMUNITY WEBSITE

Daniel Holbach writes about
the progress on the

Community part of the ubuntu.com
website. 'The first stage of the
work is largely done. Michael Hall
set up a wordpress test instance
here where we put all the updated
content, which is a great
achievement already. It’s not only
up to date, but also much more
welcoming and friendly. The
Canonical Web team should help us
update the style to match the new
ubuntu.com site', he mentions.
http://daniel.holba.ch/blog/2013/0
5/our-community-website/

ANNOUNCING THE UBUNTU

BILLBOARD PHOTO CONTEST

David Planella announces the
Ubuntu Billboard Photo

Contest for people in Russia and
Ukraine. From May 13th to the end
of May, participants can submit
pictures of billboards showing Dell
and Ubuntu for a chance to win
such “succulent prizes” as a Dell
XPS 13 with Ubuntu installed,
Ubuntu merchandise, and 100 GB
storage of Ubuntu One.
http://fridge.ubuntu.com/2013/05/
13/announcing-the-ubuntu-
billboard-photo-contest/

UBUNTU DEVELOPER

SUMMIT 13.05 CLOSING

PLENARY AND TRACK

SUMMARIES [VIDEO]

Jono Bacon and the other track
leads for the Ubuntu Developer

Summit 13.05 summarize what
took place and decisions made
during their respective tracks.
http://www.youtube.com/watch?v
=3SuSZXpdMMY

UBUNTU OPEN WEEK FOR

RARING: ALMOST HERE!

José Antonio Rey writes about
the Ubuntu Open Week for this

cycle, where he explains what this
event is about. He also mentions
that an Ask Mark! session will be
held, where "community members
are invited to ask Mark
Shuttleworth (sabdfl) questions
about the Ubuntu project." Make
sure to join us!
http://ubuntuclassroom.wordpress
.com/2013/05/20/ubuntu-open-
week-for-raring-almost-here/

http://fridge.ubuntu.com/2013/05/10/ubuntu-8-04-hardy-heron-end-of-life-reached-on-may-9-2013/
http://fridge.ubuntu.com/2013/05/10/ubuntu-10-04-lucid-lynx-desktop-end-of-life-reached-on-may-9-2013/
http://fridge.ubuntu.com/2013/05/10/ubuntu-11-10-oneiric-ocelot-end-of-life-reached-on-may-9-2013/
http://www.chrisjohnston.org/ubuntu/virtual-ubuntu-developer-summit-13-05
http://daniel.holba.ch/blog/2013/05/our-community-website/
http://fridge.ubuntu.com/2013/05/13/announcing-the-ubuntu-billboard-photo-contest/
http://www.youtube.com/watch?v=3SuSZXpdMMY
http://ubuntuclassroom.wordpress.com/2013/05/20/ubuntu-open-week-for-raring-almost-here/
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As many of you have probably
heard at one point or another,

an accepted practice for keeping
your skills as a programmer sharp,
is to learn a new language once a
year. I do my utmost to stick to
exactly that, and as such, I’m
constantly on the lookout for ways
to make it easier and less time-
consuming. This month, I’d like to
introduce you to two websites I’ve
found, and give some general tips
on how to go about learning new
programming languages (whether
you have any prior knowledge or
not).

CODECADEMY

By far the most user-friendly
option I’ve found is called
Codecademy, and it offers an
interactive editor/interpreter
method for learning Web
Fundamentals, jQuery, JavaScript,
Projects (Web), Python, Ruby, PHP
and APIs. Each of the listed topics
has an entire track that is generally
laid out nicely, and is focused
towards teaching you very specific
skills. Each of these offers a very

good basis for working with any
further language, and as such, I
can’t recommend it highly enough.
There are also a number of User-
created projects, outside of the
typical tracks, that you can jump
into, in case you’re the sort of
programmer who has trouble
deciding what you want to focus
on.

http://www.codecademy.com

Further features:
• A point-based (and percentage-
based) tracking system for
progress between the tracks, to
entice you to stick with it.
• The ability for any user to create
lessons (teaching is a great way to
cement your understanding of any
topic).
• Quick, interactive online tools for
programming. This avoids the
hassle of setting up a
programming environment,
especially for those who have
multiple devices.
• A useful hint system that supplies
just enough information to help
you when stuck.
• It presents the full, working code

at the beginning of the project, to
help you understand other
people’s code without comments
or compiling it yourself.

Who would I recommend this to? I
would recommend this to anyone
who wants to learn a programming
language. If you have no prior
experience, it should offer you all
the information you need, so long
as you are willing to thoroughly
read everything written. For those
who already have one (or more)
programming languages under
their belt, and want to simply
become more comfortable with
another, Codeacademy is a great
choice. It combines explanations
and exercises, allowing you to fly
through the tracks quickly. For
example, it took me about 3 hours
to get through the Ruby track,
which consisted of 10 chapters,
and about 238 exercises. They
aren’t the most challenging
exercises for those with
experience, but they’re still
enough to give you a grasp of the
syntax and semantics of a given
language.

KHAN ACADEMY

Khan Academy offers a fairly
large selection of free online
courses, covering a multitude of
topics. This includes, but isn’t
limited to, Computer Science,
Math, and Science. It also offers a
few test preparation options for
those studying for exams. If you’re
looking to learn more about
programming (or other topics) in a
typical classroom-type method,
Khan Academy is for you. I haven’t
personally done more than one or
two courses, but it’s mainly due to
the fact that I have covered these
topics before – both in high school
and university. From what I’ve
seen, it’s well done, and should
serve as a useful service for
anyone interested in that sort of
learning.

https://www.khanacademy.org/

Who would I recommend this to?
Anyone who learns well in a
university-like environment with
like-minded individuals and basic
exercises and some lecture-type
videos. It lends itself most to those

CCOOMMMMAANNDD && CCOONNQQUUEERR
Written by Lucas Westermann

FFrreeee OOnnlliinnee CCooddiinngg CCoouurrsseess

http://www.codecademy.com
https://www.khanacademy.org/
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Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

people who haven’t studied
courses like this before in high
school or university, or who want a
refresher for those classes. There
isn’t, admittedly, a lot of content
yet for Computer Science, but it
appears to be growing steadily.

PROJECT EULER

Project Euler is a website that
has simply one goal: to supply you
with mathematical problems.
These problems range from the
mundane, to mind-crushing feats
of calculation. The kicker? Each
problem is designed so that
manually calculating the solution is
so time-consuming as to be
impossible. As such, you’re
required to program an algorithm
(in your language of choice) to
calculate the answer. Many
questions require you to find and
implement the correct algorithm in
order to reach a solution in a
reasonable amount of time (under
a minute). Their system allows
access to the discussion thread of
that problem only when you’ve
solved it, meaning you can happily
discuss and share your algorithms
with others in that area. If you’re
not a fan of mathematics, or don’t
know any programming languages,

or lack a firm grounding in
mathematics as applied to
programming (and aren’t willing to
pick up any of these skills), then
Project Euler isn’t for you. For
anyone to whom this sounds like
fun, I wish you luck with some of
the more complex topics.

http://projecteuler.net/

Who would I recommend this to?
Fans of programming,
mathematics, and/or problem
solving. If you’re willing to learn,
you can manage fairly well, but a
certain degree of background
knowledge is helpful. I will say this:
The problems do not seem to be
sorted by difficulty. So if you get
stuck, try the next one – it might
be easier!

GENERAL TIPS

For anyone looking for my
advice on learning to program, or
to keep your skills sharp, I have
only one main piece of advice:
Program! The more you use a
language, the firmer a grasp you
will have on the theory, and the
theory is often the most difficult
to understand. Once you
understand the theory, you can

generally apply it to any language,
and learning the syntax and
semantics of a language isn’t
usually very difficult.

If you’re not sure what to
program, Project Euler can help. Or
else writing small scripts for use in
Conky can also be a great way to
get into a habit of writing script.
You do often learn the most from
larger projects, but keeping up
with the basics is useful until that
flash of inspiration that leads to a
large project comes along.

What language should I learn? It
depends entirely on what your
goal is. If you’re trying to find a
language that will help to
automate your Linux environment
(or else hoping for something to
integrate into Conky), I could
recommend Bash, Lua, or Python.
If you’re into web programming,
Ruby on Rails, PHP or Python could
also be useful. If you’re hoping to
jump into an open source project in
order to help out, most are written
in C or C++, though it depends on
what project in particular you have
your eye on. Whatever you learn,
keep in mind that the theory
behind the methods are mostly
universal, so pick whatever feels
most comfortable for you!

I’m stuck on an error, and can’t
find a solution on Google! A lot of
programming languages have IRC
channels dedicated to them. In
such rooms there are generally a
few people who are happy to try to
help you solve your issues.
Sometimes you might even bump
into the developer of the
language! The best way to get an
answer is to a) pastebin your code
and b) be concise!

I hope I’ve managed to give
anyone who is interested in
programming a starting point.
There are probably many other
relevant websites out there. If
anyone has a personal favourite,
feel free to email me at
lswest34@gmail.com with the
website, or any questions,
comments or suggestions you have
for C&C in general. If you do email
me, please include “FCM” or “C&C”
in the subject line!

COMMAND & CONQUER

mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
mailto:lswest34@gmail.com
http://projecteuler.net/
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HHOOWW--TTOO
Written by Greg Walters PPrrooggrraammmmiinngg IInn PPyytthhoonn:: PPtt 4444

We are going to take a short
detour this month from our

TVRage program to partially
answer a question from a reader. I
was asked to talk about QT
Creator, and how to use it to
design user interfaces for Python
programs.

Unfortunately, from what I can
tell, the support for QT Creator
isn't ready yet for Python. It IS
being worked on, but is not “ready
for prime time” quite yet.

So, in an effort to get us ready
for that future article, we will work
with QT4 Designer. You will need
to install (if they aren't already)
python-qt4, qt4-dev-tools, python-
qt4-dev, pyqt4-dev-tools and
libqt4-dev.

Once that is done, you can find
QT4 Designer under Applications |
Programming. Go ahead and start
it up. You should be presented
with something like the following:

Make sure that 'Main Window'
is selected, and click the 'Create'
button. Now you will have a blank

form that you can drag and drop
controls onto.

The first thing we want to do is
resize the main window. Make it
about 500x300. You can tell how
big it is by looking at the Property
Editor under the geometry
property on the right side of the
designer window. Now, scroll down
on the property editor list box until
you see 'windowTitle'. Change the
text from 'MainWindow' to 'Python
Test1'. You should see the title bar
of our design window change to
'Python Test1 – untitled*'. Now is a

good time to save our project.
Name it 'pytest1.ui'. Next, we will
put a button on our form. This will
be an exit button to end the test
program. On the left side of the
designer window you will see all of
the controls that are available. Find
the 'Buttons' section and drag and
drop the 'Push Button' control
onto the form. Unlike the GUI
designers we have used in the
past, you don't have to create grids
to contain your controls when you
use QT4 Designer. Move the
button to near center-bottom of
the form. If you look at the

Property Editor under geometry,
you will see something like this:

[(200,260), 97x27]

In the parentheses are the X
and Y positions of the object
(push-button in this case) on the
form, followed by its width and
height. I moved mine to 200,260.

Just above that is the
objectName property—which, by
default, is set to 'pushButton'.
Change that to 'btnExit'. Now
scroll down on the Property Editor
list to the 'QAbstractButton'
section, and set the 'text' property
to 'Exit'. You can see on our form
that the text on the button has
changed.

Now, add another button and
position it at 200,200. Change its
objectName property to
'btnClickMe,' and set the text to
'Click Me!'.

Next add a label. You will find it
in the toolbox on the left under
'DisplayWidgets'. Put it close to
the center of the form (I put mine
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HOWTO - PROGRAMMING PYTHON Pt44
at 210,130), and set its
objectName property to lblDisplay.
We will want to make it bigger
than what it is by default, so set its
size to somewhere around 221 x
20. In the property editor, scroll
down to the 'Qlabel’ section, and
set the Horizontal alignment to
'AlignHCenter'. Change the text to
blank. We will set the text in
code—when the btnClickMe is
clicked. Now save the project
again.

SLOTS & SIGNALS

This next section might be a bit
difficult to wrap your head around,
especially if you have been with us
for a long time and have dealt with
the previous GUI designers. In the
other designers, we used events
that were raised when an object
was clicked, like a button. In QT4
Designer, events are called Signals,
and the function that is called by
that signal is called a Slot. So, for
our Exit button, we use the Click
signal to call the Main Window
Close slot. Are you totally
confused right now? I was when I
first dealt with QT, but it begins to
make sense after a while.

Fortunately, there is a very easy

way to use predefined slots &
signals. If you press the F4 button
on the keyboard, you will be in the
Edit Signals & Slots mode. (To get
out of the Edit Signals & Slots
mode, press F3.) Now, left click and
hold on the Exit button, and drag
slightly up and to the right, off the
button onto the main form, then
release the click. You will see a
dialog pop up that looks
something like that shown above.

This will give us an easy way to
connect the clicked signal to the
form. Select the first option on the
left which should be 'clicked()'. This
will enable the right side of the
window and select the 'close()'
option from the list, then click
'OK'. You will see something that
looks like this:

The click signal (event) is linked
to the Close routine of the main
window.

For the btnClickMe clicked
signal, we will do that in code.

Save the file one more time.
Exit QT4 Designer and open a
terminal. Change to the directory
that you saved the file in. Now we
will generate a python file by using
the command line tool pyuic4. This
will read the .ui file. The command
will be:

pyuic4 -x pytest1.ui -o
pytest1.py

The -x parameter says to
include the code to run and display
the UI. The -o parameter says to
create an output file rather than
just display the file in stdout. One
important thing to note here. Be
SURE to have everything done in
QT4 Designer before you create
the python file. Otherwise, it will
be completely rewritten and you'll
have to start over from scratch.

Once you've done this, you will
have your python file. Open it up in
your favorite editor.

The file itself is only about 65
lines long, including comments. We
had only a few controls so, it
wouldn't be very long. I'm not
going to show a great deal of the
code. You should be able to follow
most all of the code by now.
However we will be creating and
adding to the code in order to put
the functionality in to set the label
text.

The first thing we need to do is
copy the signal & slot line and
modify it. Somewhere around line
47 should be the following code:

QtCore.QObject.connect(self.b
tnExit,
QtCore.SIGNAL(_fromUtf8("clic
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HOWTO - PROGRAMMING PYTHON Pt44
ked()")), MainWindow.close)

Copy that, and, right below it,
paste the copy. Then change it to:

QtCore.QObject.connect(self.b
tnClickMe,
QtCore.SIGNAL(_fromUtf8("clic
ked()")), self.SetLabelText)

This will then create the
signal/slot connection to our
routine that will set the label text.
Under the retranslateUi routine
add the following code:

def SetLabelText(self):

self.lblDisplay.setText(_from
Utf8("That Tickles!!!"))

I got the label setText
information from the initialization
line in the setupUi routine.

Now run your code. Everything
should work as expected.

Although this is a VERY simple

example, I'm sure you are
advanced enough to play with QT4
Designer and get an idea of the
power of the tool.

Next month, we will return
from our detour and start working
on the user interface for our
TVRage program.

As always, the code can be
found on pastebin at
http://pastebin.com/98fSasdb for
the .ui code, and
http://pastebin.com/yC30B885 for
the python code.

See you next time.

Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

MY STORY QUICKIE
By Anthony Venable

This story begins at the beginning of 2010. I was broke at the
time so I was trying to find a free operating system. I needed

something I could run on my PCs at home. I had searched on the
Internet, but found nothing useful for a long time. But one day I
was at Barnes and Noble and I saw a magazine for Linux. (While I
had heard of Linux before, I never thought of it as something I
would ever be able to use.) When I asked people who I knew were
computer professionals, I was told it was for people that were
experts, and difficult to use. I never heard anything positive about
it. I am so amazed that I hadn’t came across it sooner.

When I read the magazine I became exposed to Ubuntu 9.10 -
Karmic Koala. It sounded so good, as if it was exactly what I was
looking for. As a result, I got very excited took it home, and to my
surprise had such an easy time installing it to my PC that I decided
to run it along with Windows XP as a dual boot system. All I did
was put the live CD in the drive and the instructions were step by
step you would have to be pretty slow to not get how to set
things up.

Since then I have been very satisfied with Ubuntu in general
and I have been able to check out later versions of it such as 10.04
(Maverick Meerkat) and 10.10 Lucid Lynx. I looked forward to
future versiobs for how they integrate multi-touch even more
than 10.04.

This experience just goes to show once again how I manage to
find the coolest stuff by accident.

http://www.thedesignatedgeek.net
http://pastebin.com/98fSasdb
http://pastebin.com/yC30B885
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Being able to create formulas in
the LibreOffice Math module

is great, but what if you need to
insert a formula into a text
document? The integration
between Writer and Math allows
you to insert formulas into your
text, to number equations, to
reference numbered equations,
and to insert equations created in
the Math module.

INSERTING A FORMULA INTO

WRITER

Insert a formula through the
menus with Insert > Object >

Formula. A formula editor window
will open at the bottom of the
Writer window, and the floating
Elements window will open. A
frame border will appear in the
document where the formula will
be displayed. You can use the
formula editor just as you would in
the Math module. When you are
finished creating your formula,
press the ESC key, or click
anywhere in the document outside
the formula frame.

In Writer, formulas are OLE
objects, and, by default, are
inserted as characters, meaning
they stay in line with the text. You

can change the way text flows
around the formula by changing
the anchor point. Right-click on the
formula, Anchor > To Page. With
the formula anchored to the page,
you can move it to wherever you
want in the document.

FORMULA EDITOR AS A
FLOATING WINDOW

If the formula editor being at
the bottom doesn't work for you,
you can detach it as a floating
window by CTRL double-clicking
the border. You can also click and
drag the border to detach the

formula editor. Once it is detached,
you can move it to wherever best
suits you. CTRL double-click to
reattach the formula editor back to
the bottom of the screen.

NUMBERING AND

REFERENCING EQUATIONS

Many times you will need to
number equations in order to
reference them in your text. Writer
makes this easy for you by
managing the references for you.
Numbering equations is one of
Writer's best hidden features.

On a new line in Writer, type
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“fn” and press F3. The “fn” is
replaced by a numbered equation.
Double-click the equation to edit it
and insert your own equation.

To create a reference to the
numbered equation, choose Insert
> Cross-reference from the menu
bar. Under type, select Text. In the
Selection list, select the equation
you want to reference. Under the
Insert reference to list, select
either Reference or Numbering.
Reference will include the
parenthesis but numbering will use
just a number.

TEXT MODE

In most cases, you will number

and reference your large formulas.
Sometimes, you will need to use a
larger formula in running text.
When you do, use Format > Text
Mode while editing the formula.
Text Mode will attempt to make
the formula fit the height of the
text. Numerators and
denominators are shrunk, and
limits for sums and integrals are
pushed to the right rather than top
and bottom.

EDITING THE FORMULA OLE
OBJECT

As I mentioned earlier, formulas
are displayed in OLE object frames
in Writer. This means you can add
backgrounds, borders, word wrap,

and margins to your formula. To
change a formula object frame,
select the formula by clicking it
once, and Format > Object/Frame
from the menus. The object dialog
will open. You can also open the
object dialog by right-clicking the
formula, then click Object.

If you need to set defaults that
apply to all formula objects, you
can edit the formula frame style in
the styles window. You will find the
formula style under the frames
category of the Styles and

formatting window.

CREATE A FORMULA

LIBRARY

If you use formulas often in
your documents, you might want
to create a formula library. When
you save formulas created in the
Math module, they save as ODF
files. You can save formulas from
your documents by right-clicking
them and selecting “Save Copy as”.
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Elmer Perry's history of working,
and programming, computers
involves an Apple IIE, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.

HOWTO - LIBREOFFICE Pt26
To insert a formula from your

library, select Insert > Object > OLE
Object from the menu bar. Select
“Insert from file” and browse or
type in the path for the file ODF
file to insert.

CONCLUSIONS

Using formulas in Writer is
actually very easy, making the
creation of documents with
advanced mathematics a fairly
simple task. You can number
formulas and reference them in
your text. Using text mode, you
can create formulas in your
paragraph text which aligns as well
as possible with the flow of the
text. Change the appearance of
your formula by editing the frame
of the inserted OLE object. Import
formulas you create in the Math
module into your document by
inserting an OLE object.

QUICK REVIEW: UBUNTU 4.10
by Anas Alsaidy

I was reading that the magazine needs us to help, so I decided to write about my experience with this
old distro. Usually the reviews are about new and modern stuff, but I wanted to make this a little more
quirky than the others.

After downloading the ISO file I burned it to a CD, rebooted my computer, and started the CD. I did have
a problem with the CD not booting. It would hang on loading. So, I had to try it VirtualBox. In VirtualBox I
had no problems with booting it at all and it worked exactly as expected.

The first thing I noticed was the good old GNOME desktop environment that I really liked. The second
thing was the old versions of modern apps such as GIMP, OpenOffice, Gedit, etc.

CONS:
• I really didn't like the horrible wallpaper even for an OS released in 2004.
• I also didn't like the ugly brown theme. Luckily though, there were lots of theme that I could change
between.
• I had a problem that it wouldn't allow me to save anything, but I think that was my computer at fault.

PROS:
• It's fast. Really fast.
• I didn't have any problems with multi-tasking
• I really liked the old GNOME panels the settings manager. Although, not the theme!

I said before that it was fast, because it really is I ran lots of applications
and nothing went wrong, except for GIMP. It made the whole system lag
and I had to restart the machine, but no problem as I'm using VirualBox.
But everything else was very fast.

Ubuntu 4.10 was definitely a great OS but apparently it can't replace
the newer versions of Ubuntu. But honestly I did like this OS and it really
looked like the the newer versions would be good, and that really is what
happened.
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There are basically two ways in
which we can store data on

disk. Historically, we had to set up
a number of files. It was necessary
for each program to issue reads
and writes at the file level, in the
correct manner, to ensure that the
“database” was maintained in a
correct state—so this was a kind of
“database” but it had to be re-
invented for each major
application. The database was
effectively hard-coded into the
software, and a small change to
the database could potentially
require massive programming
effort.

A true database is simply a
structured collection of data.
There are many varieties of
database, but by far the most
popular kind uses “Structured
Query Language” or SQL as the
language used for access and
control. There are many
implementations of SQL
databases, and SQLite is a popular
one. The choice of database
depends upon the application; if it
is networked or could involve many
simultaneous update processes,

then SQLite would not be
recommended. However, at the
“low end,” with non-networking
and few simultaneous update
processes, SQLite has many
advantages—such as near-zero
configuration, small memory
footprint, and still gives a
maximum database size of about 2
TeraBytes. It claims to occupy
about 350 KBytes of memory. So
SQLite is ideal for any PC. It is
(perhaps) the most widely used
database available—and it just
happens to be open source. It may
even be in use on your mobile
phone...

With our relational database we
can demand:-
• Complex data structures.
• Ease of use.
• Simple access from any program
language.
• Database instructions should be
in an English-like language.
• Atomicity—if a transaction
performs multiple updates to
multiple files, it either performs all
the updates (if it succeeds) or no
updates (if it fails).

Luckily (for us), the relational
database was invented some time
ago (1970s), together with a simple
language—“Structured Query
Language” or SQL, with which to
control and access it. All versions
of SQL are broadly standardised,
so we have to learn it only once.

An example of a simple SQL
statement (to insert some data
into a database):

INSERT INTO table1
VALUES(250,84,'The quick
brown fox jumped over the
lazy dog');

An SQL command starts with a
verb, possibly followed by several
qualifiers, and is always terminated
with a semicolon. I have followed a
common convention of writing SQL
keywords in uppercase.

Apart from the zero-
configuration aspect of SQLite,
there is an additional advantage
for the SQL neophyte: Firefox uses
SQLite to manage internal caches,
bookmarks, history, etc. So Firefox
found it useful to write a GUI
extension which makes it very easy

to prototype and create your own
SQLite database.

Virtually every programming
language supports SQL—you can
even run the program from the
command line—although we shall
prototype our database the simple
way. I will give one or two simple
examples of Python usage.

Hopefully, you use Firefox as
your browser, as you need to install
an extension (SQLite Manager
0.7.7) in order to load a full GUI
interface which will allow for
prompting, execution and testing
of your SQL. Once you like what
you see, you can transfer the SQL
statements to your favourite
programming language, which
could be anything from BASH to
BASIC.

To add the relevant extension
to Firefox:-
• From the Firefox menu click on
the Tools > add-ons menu.
• In the search box enter SQLite
Manager; you should see one entry
• Click on this and you should see a
dialog box asking you to confirm
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your decision;

You will now need to restart
Firefox for this to take effect.

We are now set to go—but we
should do a bit of database design
before diving in.

An SQL database has a very
simple structure: it consists of a
number of tables which look very
much like spreadsheets; they have
a preset number of columns
(defined when the table was
created), and an unlimited number
of rows.

There are effectively no row
labels; we use the data itself to
relate a row of data in one table to
a row of data in another table.
There is no limit to the number of
tables—although the number of
tables rarely gets too large.

This probably raises questions

of how can it work efficiently on
large databases. It doesn't just
plough through masses of data
(although this can happen with bad
designs). Behind the scenes, SQL
maintains a number of indexes,
some created automatically and
some optionally created by the
user. Many database operations
are simply operations on these
efficient indexes.

It's worth pointing out that a
SQLite database is stored as a
single large file—which makes
backups (very important) a
particularly easy task.

THE APPLICATION

An artificial example:- suppose
we have a bunch of students who
will each be sitting a number of
exams. We need to record the
exams taken, the student name
and address details (so we know
where to post the results to). The
accent is very much on simplicity!

I've tried to follow a simple
naming convention:- to prefix table
names with 'T', column names are
in lower-case, and SQL statements
are in upper-case.

We shall create four tables:
Tstudent (one row per student)
Taddress (one row per address line
per student)
Texam_name (one row for each
exam set – a list of exam titles)
Texams (one row per student per
exam taken)

Note that we could have stored
the address in the Tstudent table
as a preset number of fields—but
how many? There is bound to be
someone who requires more lines
for their address than we had
planned for.

This process whereby a
repeating field is moved into a
subsidiary table is an example of
“normalisation” and is an
important feature of database
design.

A similar reasoning justifies the
creation of the Texam_name as we
don't want to be forced to re-enter
the full exam title for each
student—we can just enter an
exam identifier.

First we need to create our
database, so it's time to launch
Firefox, and, from the Firefox
menu, click on Tools > SQLite
Manager

You will be presented with a
sparse looking screen, so choose
Database from the menu and click
on the new Database entry:-

We are going to call our
database the “Exam” database, so
enter Exam into the dialog
box—the system will add .sqlite
onto the end, and ask you to
choose a folder to put it in—I
suggest you choose your home
directory.
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This gives us a rather
complicated looking initial screen
(shown above).

The reason for the rather
complicated screen is that SQLite
builds its own database to hold
metadata about our tables and any
relationships between them. This
is maintained internally by SQLite
and we have relatively little access
to it.

So it's now time to create our
first table. In practice, it's a good
idea to set out your tables on
paper before entering them into
the computer as there is rarely an
absolutely “correct” way to design
these things.

Tstudent will have four columns
(these are sometimes called fields).

This lists all the major
operations we can do to

tables—(Drop is SQL-speak for
deleting a table).

We want to create a table; so
we proceed and are presented
with a form to define our table
(shown above).

SQLite is different from other
SQL databases in that there are
only a few different data classes
(INTEGER, REAL, TEXT, NULL,

BLOB); no size is mentioned as
SQLite will use only as much space
as is necessary. A BLOB (“Binary
Large OBject”) is any collection of
binary data stored as a single
entity.

We will be prompted to confirm
that we really want to create this
table—and we are shown what the
SQL statement looks like to
achieve this:

http://en.wikipedia.org/wiki/MAC_address
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So now we have a properly
formatted table, but it still has to
be filled with data.

The student_id needs some
explanation; we have described it
as the “Primary Key”, which we
have specified as being Unique.
Here the student_id key is used as
a reference to individual student
information in this and other
tables. By specifying the “Unique”
property, the database will reject
any attempt to add a row with a
duplicate student_id value.

Primary keys may consist of
more than one column—for
example we could insist that the
combination of (surname,
forename) is our primary key, but
this wouldn't allow two students
with the same combination of
names to be enrolled. Each primary
key causes SQLite to maintain an
index.

It is usual, but not a
requirement, that a primary key
has the Unique keyword.

Although we have mentioned
primary keys, these are really the
only kind of key to consider. It
should be mentioned that there is

a rather useful idea of something
called a “foreign key” and we will
give an example of its utility later.

We can now enroll some
students (one at a time). The
college has decided that the
student_id is to be printed on all
documentation, and will consist of
a letter followed by seven digits.
This is an important constraint
which should (and could be)
checked by the database. However,
for the sake of simplicity, we shall
assume that it is handled correctly
by the user program.

Select the Tstudent table and
take the add option:-

After entering your data, the
system will prompt you with the
appropriate SQL statement for
adding a row.

However, entering data one line
at a time will lead to very poor
database performance. Because
we didn't specify how many SQL
statements form a logical

transaction unit, SQLite assumes
the single INSERT statement is an
entire transaction. The system
needs to lock the database against
update, check there isn't a pre-
existing row with the same unique
key, write the data row, and flush
the data to the disk to ensure the
integrity of the database. All this
activity is probably going to
require a couple of rotations of the
disk drive. We gain “atomicity” (a
row is never partially written) but
suffer a large performance penalty
in disk-wait time.

The solution is to carry out a
number of database updates as
one logical transaction. We simply
do a little more work and spend
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less time waiting for disks to
respond.

We mark the beginning and end
of the transaction with SQL
statements

BEGIN TRANSACTION;
…
...
COMMIT;

We can enter any reasonable
number of statements (thousands)
that make sense—covering
multiple tables and various
operations. When we reach the
COMMIT statement, the database
can be considered to have been
properly updated. Alternatively, if
an error occurs part way through
(or we issue the ROLLBACK
command), the database is placed
back into the state it was in before
we started our transaction.

So let’s add a few more
students (we know we want to
execute some SQL, and “Data
manipulation” seems the most
appropriate).

We get a prompt of

INSERT INTO tableName
[(column-list)] VALUES(value-
list)

Bearing in mind
our successful one-
row attempt, it
seems reasonable to
try pasting the
following piece of
SQL into the
“Execute SQL” box.
It's quite long, but
it's just a lump of
repetitive code
(shown above right).

One of those names is a real
person (shown above).

However, when we attempt to
run this piece of SQL, we get:

This is unexpected—but it turns
out that Firefox always arranges
for invisible BEGIN and COMMIT
instructions to be inserted into any
SQL that is run. The error

(correctly) says that you can't nest
transactions.

No programming language
would ever do this for you; in a
real-life situation, you would want
to intercept some errors, and
either correct them or simply
accept them as errors which are
not serious enough to cause a
transaction to fail.

In this case, we just remove the
BEGIN and COMMIT statements
and it runs perfectly. There is a
very simple SQL command to
display all rows and all columns of
a table—so we'll run it to prove our
table contains the “right stuff”
(shown on the next page, top left).

So far, we have managed to
create just one table. It is only
when we have several tables that

BEGIN TRANSACTION;
INSERT INTO "Tstudent" VALUES('L6181072','Johnson','Claire','J');
INSERT INTO "Tstudent" VALUES('J2456312','Williams','Charles',NULL);
INSERT INTO "Tstudent" VALUES('M1234700','Jones','Joan','A');
INSERT INTO "Tstudent" VALUES('K1348221','Brown','Dennis','');
INSERT INTO "Tstudent" VALUES('J9274173','Moore','Linda','S');
INSERT INTO "Tstudent" VALUES('L4522786','Taylor','Percy','ABC');
INSERT INTO "Tstudent" VALUES('L3665921','Anderson','Janet',NULL);
INSERT INTO "Tstudent" VALUES('M2287567','Garcia','Carmen','G');
INSERT INTO "Tstudent" VALUES('L7234219','Martinez',NULL,'');
INSERT INTO "Tstudent" VALUES('J8445578','Montagu-Stuart-Wortley-
Mackenzie','Edward',NULL);
COMMIT;
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we can map the relationships
between them. You will be pleased
to learn that the Firefox add-on
allows you to import an initial data
load if you have appropriate data
available as CSV, XML or SQL
source; it is also possible to export
a table to these file types too. We

still need to write the SQL
statements to create the tables,
but we can import our base data
from spreadsheet(s).

For Taddress we shall specify
the columns as follows:

Note that we could have
specified TWO columns for our
primary key and the corresponding
SQL command generated would
be:-

CREATE TABLE "Taddress"
("student_id" CHAR NOT NULL
UNIQUE , "line_no" INTEGER
NOT NULL UNIQUE , "address"
CHAR, PRIMARY KEY
("student_id", "line_no"));

However, we choose to use a
feature of SQLite, provided that
we have only one primary key
column and that it is of type
INTEGER, we can ask for it to be
auto-incremented on each write to
the table. You may have noticed
that a column (called rowid) is
automatically inserted in each row
of a table; by using autoincrement
we get an ascending sequence of
line numbers (possibly with gaps in
between).

Since it would be meaningless
to allow the entry of the address
of someone who is not in the
Tstudent table, we need to prevent
this. This kind of problem is
described as a “referential
integrity issue,” and it could be
prevented by relevant program
coding. However, the problem is
really intrinsic to our database

design, and a database with dozens
of tables would suffer many more
referential integrity issues.

The solution lies in entering the
data rules into the database, so
that the database can enforce data
integrity (note that although the
same name of student_id was used
in both the Tstudent and Taddress
tables, this doesn't mean that
there is any implicit connection
between the two tables).

This is the situation alluded to
earlier of a “foreign key”—here we
would want any attempt to update
Taddress to check that the
student_id already exists in
Tstudent. We can think of Tstudent
as being the “parent” whilst the
corresponding multiple address
rows are “child” entries. Potential
problems could also happen if we
were to delete a row from the
parent, but we can instruct the
database to automatically delete
all the child entries.

Unfortunately, the Firefox GUI
does not support the generation
of SQL for foreign keys.
Furthermore, it actually has
foreign key supported switched off
(by default) this is easily fixed by
telling Firefox to run a command to
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enable foreign keys!

It is important to type the
PRAGMA foreign_keys=ON;
correctly, and press save. You need
to do this only once for each
database you create, as future
connections to the database will
automatically run this PRAGMA
command.

The correct syntax for the
foreign key specification can be
rather complicated. With a little
practice, this is straightforward;
the following will fix the situation:

DROP TABLE "Taddress" ;
delete the existing table and
data...

CREATE TABLE "Taddress"
("student_id" CHAR NOT NULL
,"line_no" INTEGER PRIMARY
KEY AUTOINCREMENT NOT NULL
,"address" CHAR, FOREIGN
KEY("student_id") REFERENCES
Tstudent ("student_id") ON

DELETE CASCADE);

This will cause updates to check
that the FOREIGN
KEY("student_id") (in Taddress)
REFERENCES (matches) in the
table Tstudent ("student_id"
column). The ON DELETE CASCADE
phrase will cause any deletion of a
student in the parent (Tstudent) to
delete all relevant instances from
Taddress.

We can summarise the major
constraints we can place on a
column:
• NOT NULL
• UNIQUE
• PRIMARY KEY
• FOREIGN KEY
• CHECK e.g. CHECK(price > 0)
• DEFAULT (the value to be used if
none is supplied)

We can try and add an address
line for a non-existent student:-

Note that only two input
parameters are needed

This gives an error
message—foreign key constraint

failed.

An attempt to add a valid
student will succeed.

We don't really care whether
the line number of the address is 1,
2, 3, … or not—just that it is
increasing. We have arranged for
the database to do it and save
some work in our program.

A simple example (in Python) of
adding just a few address lines
would be:

#! /usr/bin/python3.2
# -*- coding: utf-8 -*-
import sqlite3 as lite
import sys
valid_data = [('K1348221', None, 'Radio Free Albemuth'),

('K1348221', None, 'VALIS'),
('M1234700', None, '27 High Street'),
('M1234700', None, 'Somewhere Town'),
('M1234700', None, 'United Kingdom')
]

con = None
con = lite.connect('Exam.sqlite') # Make connection with
database
if con:

con.execute('BEGIN TRANSACTION;')
con.executemany('INSERT INTO Taddress VALUES(?,?,?);',

valid_data)
con.commit()
con.close() # Disconnect from database
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Note that the interface

converts a Python “None” into an
SQL “Null”, there is no error
handling, and the address line
sequence number is generated
(correctly) by the database.

We now need to create a new,
super simple, table which will be a
“codes file”; it associates exam
codes with their titles. Since it's so
simple, we can just type it into the
“Execute SQL” area without any
prompting.

CREATE TABLE Texam_name
(exam_id CHAR PRIMARY KEY NOT
NULL UNIQUE, exam_title
CHAR);

Because we have the data
available, we shall load the initial
data from a CSV file (created from
a spreadsheet):

We now have a number of
tables and we are in a position to
use one of the most powerful
features of SQL—when we
combine two or more tables
together. To do this we use the
JOIN keyword. There are two main
varieties of JOIN available – by far
the most common type of JOIN is a
matching columns JOIN
(technically an INNER JOIN). You
can guess the name of the other
kind of JOIN!

When specifying our JOIN, a
problem that sometimes occurs is
that we have used the same name
for a column in two tables – but
perhaps it has different meanings –
in which case we need to qualify
the column name by table name.
As an example:

SELECT surname, forename,
address FROM Tstudent AS S

JOIN Taddress AS A
ON S.student_id =

A.student_id;

(The multiple lines are purely
for readability), we enter this into
the “execute SQL” section:- Note
the optional temporary renaming
of the tables to single letter
names, purely so the full
qualification of field names is
abbreviated. We don't have much
data in our database, so it looks
like that shown below.

It happens frequently that we
make a habit of making up new
names for the same thing, so in
fact our student_id means the
same thing in the two tables. As a
shortcut we have the idea of a
“NATURAL JOIN”—where any
matching names are assumed to be

required to be matched; so an
equivalent to the previous JOIN is:

SELECT surname, forename,
address FROM Tstudent

NATURAL JOIN Taddress;

Note that a NATURAL JOIN can
give unexpected results if extra
columns are added to the tables at
a later date.

If we expect to want to use our
address list periodically, then we
should create a View (using our
SELECT statement above). There is
no overhead in doing so, since it is
just an instruction on how to view
existing tables. However, it is
important to realize that for the
same reason, only tables can be
updated—views are just a
reflection of the current state of
the tables; the data in views
cannot be updated.
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We can also create joins which
are a JOIN of a table with itself, to
create Views of a single
table—perhaps to hide a
particularly complex piece of SQL.
It's also possible to join more than
two tables in one statement—but
then things tend to get
complicated!

If we have a very big
database—many thousands of
rows in several
tables—performance will suffer. In
this case, we should look at how
we are using our database,
especially with respect to JOINs,
and specify the Index  Create
index option. This is likely to speed
up queries, at a small penalty for
database updates (we have to
maintain each additional index).

The last major feature that can
be used is the TRIGGER statement
– where it is desirable that some
database event should 'trigger' a
sequence of actions. This is really a
rather advanced topic and I refer
you elsewhere!

We still have one last table to
construct—the one that links the
students with their exams.

Texams student_id exam_id
score

The exam score will be zero if
they have not sat the exam yet. To
access the score, we need the
combination of student_id and
exam_id to be our unique (primary
key). This is a slightly tricky case,
because we don't allow a student
to take the same exam twice, but
the data structure means that we
need to accept duplicate
student_id's and duplicate
exam_id's, but reject any
combinations of the two which are
not unique. This is a situation
where a composite primary key has
the effect we want.

So Firefox produces:

CREATE TABLE "Texams"
("student_id" CHAR NOT NULL,
"exam_id" CHAR NOT NULL,
"score" INTEGER DEFAULT 0,
PRIMARY KEY ("student_id",
"exam_id"))

We should really declare
student_id to be a foreign key so
that it is validated against Tstudent
and similarly exam_id should be a
foreign key so that it is validated
against Texam_name. So we delete
(with DROP Texams) and execute
the following SQL; as you can see,
it is effectively similar to our
previous encounter with foreign
keys.

CREATE TABLE "Texams"
("student_id" CHAR NOT NULL,
"exam_id" CHAR NOT NULL,
"score" INTEGER DEFAULT 0,

CHECK (score >= 0),

PRIMARY KEY ("student_id",
"exam_id"),

FOREIGN KEY("student_id")
REFERENCES Tstudent
("student_id"),

FOREIGN KEY("exam_id")
REFERENCES Texam_name
("exam_id"));

(Actually, this is not quite
correct as SQLite allows character
values to be stored in numeric
columns—so the CHECK statement
would not work properly; we could
fix this with a more complicated
CHECK statement—but it wouldn't
add anything to the readability. So
we will leave it alone).

We can enter all of the test
cases using INSERT, and they
should all behave properly.

With our last table we are in a
position to do something typical.
The college has a few rather
arbitrary rules, which change from
time to time, so they don't really
need to be enforced by the
database. For example: “No
student can enroll for M829,
without achieving a pass in M823
previously”. This is easy to do in
SQL with a little bit of decision in a



full circle magazine #73 23 contents ^

HOWTO - AN INTRO TO SQLITE
program.

As a slight variation, I've
supplied a version that runs in a
terminal screen; it could easily be
converted to a BASH script. Many
programs can have the database
open, concurrently.

jeremy@HECTOR:~$ # An example
where student K1001001 wants
to enroll on M829

jeremy@HECTOR:~$ sqlite3
Exam.sqlite # Open
database

SQLite version 3.7.9 2011-11-
01 00:52:41

Enter ".help" for
instructions

Enter SQL statements
terminated with a ";"

sqlite> SELECT count(*) FROM
Texams WHERE ("student_id" =
"K1001001" AND

...> "exam_id" = "M823"
AND "score" >= 40 );

1

sqlite> INSERT INTO Texams
VALUES("K1001001", "M829",
0);

sqlite> .exit

jeremy@HECTOR:~$

The SELECT count(*) …
statement is an example of one of
the many built-in “aggregate”
functions – here the number of
rows that meet the conditions in
the WHERE conditional, in this case
a value of '1' is returned. So we can
add a row (with a score of zero) for
M829.

I shall give a number of
references for more advanced use;
but even if you want only a single
keyed file or two—perhaps for an
address book—a database is a big
advance over some complex coding
solution.

References:

http://www.sqlite.org/docs.html -
The full reference; not a tutorial.

http://zetcode.com/databases/sqli
tetutorial/ - A very concise SQL
tutorial.

http://zetcode.com/db/sqlitepytho
ntutorial/ - Python.

http://zetcode.com/databases/sqli
tephptutorial/ - PHP version.

http://zetcode.com/db/sqliteperltu
torial/ - Perl.

http://zetcode.com/db/sqliteruby/
- Ruby.

http://zetcode.com/db/sqlitecshar
p/ - C#.

http://zetcode.com/db/sqlitevb/ -
Visual Basic.

http://en.wikipedia.org/wiki/List_o
f_relational_database_managemen
t_systems - general interest only.

Jeremy started his computing career
on the ICL1900, later moving onto
the IBM System 38 and its
descendants (the AS400 and i-series
machines) and has since taken early
retirement.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org

http://www.sqlite.org/docs.html
http://zetcode.com/databases/sqlitetutorial/
http://zetcode.com/db/sqlitepythontutorial/
http://zetcode.com/databases/sqlitephptutorial/
http://zetcode.com/db/sqliteperltutorial/
http://zetcode.com/db/sqliteruby/
http://zetcode.com/db/sqlitecsharp/
http://zetcode.com/db/sqlitevb/
http://en.wikipedia.org/wiki/List_of_relational_database_management_systems
http://podcast.ubuntu-uk.org/
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Written by Nicholas Kopakakis BBlleennddeerr -- PPaarrtt 66aa

By default, blender has its own
renderer called Blender

Render, but my favorite is one
called “Cycles”. It is included as an
enabled add-on since version 2.64
(we are now at 2.67), and I find it
fantastic because among others
things, you can actually see the
rendered result of your models in
real-time!

But, first things first. Locate at
the top of your blender window
the pull-down button that says
“Blender Render”.

Press it to open the menu and
select “Cycles Render”.

Now, let’s arrange our windows
to take advantage of the
interactive cycles renderer.

On the upper right corner of
the 3d view window (main

window), press the
LMB and drag the
mouse left to create
a new 3d view

Then do the same with the left
window that you have, but this
time drag the mouse down to
create a third window. You must
have something like the image
below.

Move the mouse on the upper
left window, and press Numpad-0
to have camera view on it.

On the lower
left window,
press the small
white sphere
next to Object
Mode button to
display the
Viewport
shading menu

From that menu select
“Rendered”.

Now, what is actually happening
is that, in this window, the cycles

render engine creates “on the fly”
a photorealistic image of your
model. You can navigate in that
window, you can zoom in or zoom
out using the mouse wheel or +, -
from the numpad, you can pan the
view by holding the shift key and
moving the mouse, rotate the view
by holding the middle mouse
button and moving the mouse,
and, in general, any movement of
the view that we examine in part
one (FCM#68) of these articles.

This is a good time to save our
setup. On the info header (the one
that by default is the upper
window), locate the screen button
with the “Default” value in it
(foolishly named, as a bunch of
setups are the defaults in blender).

By pressing the small icon on
the left (red square), you can select
from a list of default setups. Press
the + sign next to “Default”. A
“Default.001” value appears.
Change it to a distinctive name for
example “Model” to indicate that
you use this setup when you model
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Nicholas lives and works in Greece.
He has worked for a post-production
house for several years and migrated
to Ubuntu because “it renders
faster.” You can email him at:
blender5d@gmail.com

HOWTO - BLENDER Pt 6a
objects. Then save your file with a
unique name, I saved mine as
“Basic_shapes.blend”. The next
time you open this file, the
“Model” setup will be opened as
well.

TIP: If you start a new project, or
load an old one, your custom setup
will NOT be there. Just the
defaults with blender. To have your
custom setup available anytime
you start a new project, you must
save it as the startup file by
pressing Ctrl-U. Note that if you
overwrite the startup file (by
pressing Ctrl-U), ANYTHING that
you have changed will be saved as
well. For example, if you delete the
cube and you overwrite the startup
file, then the next time the cube
won't be there! Of course you can
revert to the original startup file
(File > Load Factory Settings).

Move your mouse over the right
3d view window, and press
Numpad-5 and Numpad-1 for
Orthographic
Front view.
Grab the blue
arrow of the
cube and
move it up just
over the grip
as shown:

Press Shift-S and select Cursor
to Center if it isn't already or Press
Ctrl-C. Now add a plane and scale it
up by 10 times (by now you must
know how to do that). Create a
Cone and a UV Sphere. Also
smooth them. Move them in order
to have them in good view on the
upper left 3d view window (the
camera view window).

Like the image below.

Select the plane and press the
material tab on the right under
properties window (shown top
right).

A different set of things to
tweak than the Blender Render!
Press the New button (as in
Blender Renderer) to add a new
material. Name it “ground”. Under
Surface, you see the default value
that is “Diffuse BSDF”. This is like
the Diffuse that we used in

FCM#72 to paint our objects. Press
it and from the menu select
“Glossy”.

Almost instantly (depending
upon your CPU power) you can
inspect the Rendered 3d window
what you’ve achieved so far.
Impressive for just few clicks! Now,
if you like, press the color button
and assign a color to your glossy,
mirror like, surface. I made it
purple (R:0.5,G:0.4,B:0.8). As you
change the color, Cycles starts to
render the result. You have a
preview really fast.

Now select the cube, add a new
material, and set the surface type

to Anisotropic BSDF to give a
metallic feeling to our cube. Maybe
my favorite material shader.

Above is what we have so far.

More on this subject next
month...

mailto:blender5d@gmail.com
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HHOOWW--TTOO
Written by Mark Crutch IInnkkssccaappee -- PPaarrtt 1133

One thing you've probably
noticed about Inkscape

throughout the course of this
series is that it operates with a
stack of objects placed one above
another—the “z-order.” You can
introduce some overall structure
by putting objects into groups and
layers, but it's simply not possible
to create an element that passes
both over and under another
object.

Because we're mostly
interested in creating an artistic
result, the solution is simply to put
the object on top, and then
remove the part that would be
hidden behind our second object.
One way to remove the hidden
part is to edit the paths that make
up our problem object, perhaps
using Boolean operations to cut
out sections. But what if the object
is complex, such as a group of
many individual elements that
would each have to be cut
independently? A better option in
this case would be to tell Inkscape
that it should draw only certain
areas, and leave the others
transparent for the background

object to show through. This is
done by creating a path and
applying it as a “clip path.” Any
part of the object inside the path
will be visible, whereas the parts
that are outside it are not drawn at
all.

As an example let's resurrect
the snowman from earlier in this
series, and give him a scarf. We
could do this simply by drawing the
front part of the scarf onto the
snowman, but, in this contrived
case, our scarf already has a back
section that we need to clip out of
the final image.

Despite its name, a clip path
doesn't have to be a path. It can be
any closed shape—a rectangle,
oval, star or polygon. It can also be
a complex path which contains

multiple sub-paths (more on that
later). Whatever shape you use,
however, it must be a single object
rather than a group or a selection
of several elements.

Defining a clip path is simple:
just draw the path or shape you
want, ensuring that it sits higher in
the z-order than the object or
group you want to clip. Now select
both the clip path and the object
you wish to clip, and use the “Set
Clip” option on the right-click
context menu. The Object > Clip >

Set menu item has the same
effect. Here, I've created an oval
on top of the scarf. I usually draw
my clipping paths with a bright
green stroke and no fill—so that
they're easy to spot against the
item I'm clipping. The color is
irrelevant, as is the thickness of
the stroke: it's purely the shape of
the path that is used to define the
clip.

Unfortunately the result of this
clip is the opposite of the effect
we're looking for. Instead of
removing the back of the scarf,
we're left with nothing but the
back of the scarf!
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Remember, clipping always
leaves the content inside the clip
path visible, and hides everything
outside it. There's no way to invert
this behaviour to hide the content
of the path, so, instead you have to
work around it by creating a more
complex path that does the job for
you. This is an ideal opportunity to
use the Boolean operations that
were introduced in Part 7 of this
series. In this case, you just draw a
rectangle that's large enough to
encompass the whole of the scarf
then, ensuring the oval is on top,
use Path > Difference to “subtract”
the oval from the rectangle.

At first glance this may appear
to simply be a rectangle with an
oval on top of it, but, in practice,

this is now a single complex path.
“Complex” simply means that it's
made up of separate sub-paths.
The rectangle is one sub-path, and
the oval is a second sub-path, but
the whole object is still considered
to be a single path and can
therefore be used for clipping.
Once again, only the area inside
the path will remain, but in this
case “inside” consists of the space
between the oval and the
rectangle; “outside” is anything
beyond the rectangle, or within the
oval. Try setting a fill if the
difference between inside and
outside isn't clear. Clipping with
this complex path gets us much
closer to our desired result.

Remember, this is a purely
visual effect. The original scarf
remains the same, it's just that

parts of it are not being drawn.
You can undo the effect at any
time by selecting a clipped object
then choosing Release Clip from
the context menu, or Object > Clip
> Release from the main menu bar.
This will return the object to its
normal appearance, and also make
the clipping path visible again.

If we add the scarf to the
snowman you can see that we're
close to the effect we're looking
for, but there are still parts of the
scarf that are being drawn in front
of the character's head.

The problem is that the clip
path we've used was just an
approximation, and needs to be
tweaked to more closely match the
section that we want to hide. In
earlier versions of Inkscape, the

only way to do this was to release
the clip, adjust the path, then re-
clip. Even with the latest version,
that's still the only option if your
clip “path” is actually a rectangle,
star, oval or other primitive object.
Thankfully, our Boolean operation
has turned our combination of an
oval and a rectangle into a fully
fledged path, which can be edited
without releasing the clip since the
0.48 version of Inkscape.

To switch to editing mode, you
have to select the clipped object
(as usual keep an eye on the status
bar where a clipped object will be
described as such), then switch to
the node tool—using the icon on
the tool palette or by pressing “n”
or F2. You should now see your
clipping path rendered as a single
pixel green path, regardless of the
color or thickness of the original
path. The green color in this mode
is the reason I choose bright green
when drawing my path in the first
place—it helps to reinforce the
mental link between green paths
and clipping. If you don't see the
green path, make sure the “Show
clipping path(s) of selected
object(s)” button (in the tool
control palette) is active.

From this point you can just edit
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Mark has been using Linux since
1994, and uses Inkscape to create
two webcomics, 'The Greys' and
'Monsters, Inked' which can both be
found at:
http://www.peppertop.com/

HOWTO - INKSCAPE Pt13
the path using the node tools that
were described in Part 6. You may
find it easier to reduce the opacity
of your clipped object so that you
can see how your clipping path
relates to the objects behind. The
changes to the clipping path will
be applied live, so you can see the
result as you work. Once you've
finished editing, return your
object's opacity to 100% if you
need to, and change to the
selection tool to hide the green
clipping path and see your results.
Remember that the spacebar can
be used as a convenient shortcut
to switch to the selection tool and
then back to the node tool during
editing, if you find that the nodes
are obscuring your view.

With a little time spent on node
editing, you should be able to
adjust the clipping path to follow
the head of the snowman and
make the scarf seem to disappear
behind it.

Sometimes you will be able to
get away with a simple rectangle
or oval as a clipping path, but
usually it's worth pressing CTRL-
SHIFT-C (or using Path > Object to
Path) before setting the clip,
simply for the advantage of being
able to edit the path without
having to un-set then re-set the
clip.

Because clipping always results
in a hard edge, it can be used to
create some effects that would
otherwise be very difficult to
produce. Wherever you have to
stop a blur from spilling over an
edge, clipping can provide a
solution. Consider something like a
semicircle which should only be
blurred on the curved edge and cut
cleanly on the
straight edge.
Without
clipping this
would be a very
difficult image
to create.

The ability to cut out parts of a
blurred object can lead to some
particularly interesting effects
when used with text. For each of
these examples, I've created two
copies of a text object. One of

them is blurred, whilst the other
has been converted to a path and
used to clip the blurred version.
Different arrangements of clip
path, blur, text, background and
color choices can produce a variety
of results.

Clipping can also be used to
work around the limited selection
of gradient types. Inkscape follows
the SVG standard in supporting
only linear and radial gradients,
but other types can often be
emulated through careful use of
blurred objects and clip paths. In
this example, a few blurred
segments and a donut-shaped
clipping path
makes an
acceptable
substitute for
a conical
gradient when
drawing a CD.

Although clipping has many
uses, and is a technique that's well
worth getting to grips with,
sometimes you need a little more
subtlety than the hard edges it
creates. Next time, we'll look at
masking—a related technique that
lets you fade objects out gradually,
rather than just stopping them
dead at the edge of a path.

http://www.peppertop.com/
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Written by Ronnie Tucker WWrriittee FFoorr FFuullll CCiirrccllee MMaaggaazziinnee

GUIDELINES

The single rule for an article is
that it must somehow be

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

• For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

document.

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

• Do not use tables or any type of
bold or italic formatting.

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game
• who makes the game
• is it free, or a paid download?
• where to get it from (give download/homepage URL)
• is it Linux native, or did you use Wine?
• your marks out of five
• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware
• what category would you put this hardware into?
• any glitches that you may have had while using the hardware?
• easy to get the hardware working in Linux?
• did you have to use Windows drivers?
• marks out of five
• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
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https://spideroak.com

Get 25% off any SpiderOak package
with the code: FullcirclemagFans

https://spideroak.com
https://spideroak.com
https://spideroak.com/mobile
https://spideroak.com
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AASSKK TTHHEE NNEEWW GGUUYY
Written by Copil Yáňez

Welcome back to Ask the New
Guy!

If you have a simple question,
and the words “rolling release
model” sound like they refer to a
new Kia electric vehicle, contact
me at copil.yanez@gmail.com.

Today’s question is:

Q: I’ve been hearing a lot about
the new version of Ubuntu, and
want to give it a try. How hard is
it to get started?

A: You’re probably talking about
Ubuntu 13.04, codenamed Raring
Ringtail. Which is a terrible
codename, by the way. There isn’t
a self-respecting undercover police
force in the world that would be
fooled by that name. Seriously,
Ubuntu, if you guys want to be
counted among the elite fake spies
(James Bond, Emma Peel, Johnny
English), you need a better name.
And British parents, apparently.

But I digress. Which is, like,
eighty-percent of these things
anyway, so I think we’re on track.

Ubuntu 13.04 was just released,
and continues the evolution
toward a faster, better, stronger
operating system. It’s like the Iron
Man of operating systems. Note to
Mark Shuttleworth: I would pay
good money to see the Ubuntu
logo on the Mark 42 start-up
screen.

There’s plenty of talk about this
version feeling peppier on older
hardware and running faster and
lighter in daily operation. This all
makes sense to those of you
who’ve been using Ubuntu forever,
and have it installed on everything
including your electric toothbrush
(in which case, may I suggest the
Gingivitis Lens?). But, for a lot of
people, this will be their first point
of contact with Linux.

The introduction of a new
version of Ubuntu is a perfect
opportunity to remind new users
how easy it is to get started in the
glamorous world of Linux! And by
glamorous, I mean exactly the
opposite of glamorous. Unless
Mark takes my suggestion from the
third paragraph. I’m just saying, can

you imagine the marketing benefit
if Robert Downey, Jr. was heard to
say, “Jarvis, handto God, Iwill
replace youwith a Roomba ifyou

don’t run theUbuntu Software

Updaterbefore everymission!”

Let’s take a look at the
installation process on an older
machine, and see if, (a) it’s easy
and, (b) it results in any
improvement.

I have an old Vaio that runs like
a tired dog on a hot day. I tried
installing an earlier version of
Ubuntu a while back. It did run
faster than the original OS but it
was still sluggish and, in the end, I
opted for Lubuntu, a lighter,
slimmer version of Ubuntu
specifically formulated to work
better on older laptops like mine.

With Raring Ringtail out in the
wild, let’s use the Vaio as a

mailto:copil.yanez@gmail.com
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testbed. Here are the specs:
Vaio running 12.10 Lubuntu
2GB RAM
Intel Core Duo 1.83 GHz

From startup, it took 25
seconds to get a login screen and
another 60 seconds to open a
browser window. Experienced
users are probably laughing right
about now because they like to
tweak their machines to minimize
startup times. AND THEY’LL
SPEND WEEKS DOING IT! Oh, hai,
have you met my good friend
Irony?

Seriously, my startup time isn’t
bad, right? Less than 90 seconds
from a cold start to surfing my
Bronie fan sites. I can live with
that.

Okay, let’s put the laptop aside
for a moment and take our new
users through the process of
finding, downloading and burning
Ubuntu 13.04 to a DVD. That may
sound daunting but it’s really easy.
If that seems too intimidating,
though, there are other options.
You can buy a DVD with the latest
version of Ubuntu from the
Ubuntu Store at
http://shop.canonical.com/index.p
hp?cPath=17. It’ll run you £5.04,

which is, like, a million dollars or
something. If you don’t want to
wait for the DVD, you can take a
trip to your local bookstore where
you’ll find Ubuntu and Linux
magazines with bundled DVDs and
articles aimed at new users. The
latter option has some advantages.
First, it gets you outdoors (that’s
the thing people spent their time
immersed in before World of
Warcraft came along). Second, the
bundled DVD usually includes a
bunch of different Linux flavors
that you can try—without
installing anything until you find
one you really like. The Ubuntu
version you burn yourself also
gives you this “LiveCD” option.

Skip ahead if you already have
an Ubuntu DVD. Otherwise, let’s
get started.

I did all the following from my
Ubuntu desktop. But you can do
this from a PC or Mac if that’s how
you roll.

The first thing you need is the
newest ISO image which is. . .who
cares? It’s some kind of packaged
program that blah, blah, blah.
Listen, do you need to know how
those 3D glasses work in order to
watch Tony Stark flying toward

your face? No. You just perch them
on your nose and look toward the
screen. Go here
http://www.ubuntu.com/download
/desktop, and click on UBUNTU
13.04. But it says Choose Your
Flavor? Flavor, shmavor, just click
already.

If you’re feeling generous, you
can contribute to the Ubuntu
Project. Otherwise, just click on
Not Now, Take Me To The
Download. Choose where to put
the file and go get yourself a beer.
You’ve earned it.

If you’re feeling frisky and know
about torrents, you can download

the same file here
http://www.ubuntu.com/download
/alternative-downloads, choose
the Ubuntu 13.04 Desktop (32-bit).
In my case, the download took
about 10 minutes.

Once you have a file labeled
ubuntu-13.04-desktop-i386.iso on
your computer, put a blank DVD in
your optical drive, right click on the
iso file and select Write to Disk
(that’s in Ubuntu, other OSs will
have a similar way of writing the
file to DVD). Once you click Burn,
go get yourself another beer.
You’ve earned this one, too.

How long did burning the DVD

ASK THE NEW GUY

http://shop.canonical.com/index.php?cPath=17
http://www.ubuntu.com/download/desktop
http://www.ubuntu.com/download/alternative-downloads
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Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).

take? I dunno, five minutes? I was
too drunk from all my celebratory
alcohol to do a very good job of
timing the process.

Once I sobered up and found
my pants, I put the shiny new DVD
into the Vaio’s drive and rebooted.
The process should be pretty
automatic from this point forward,
but if you have trouble with your
computer not booting from the
DVD, the documentation here
might help
https://help.ubuntu.com/communi
ty/BootFromCD.

On my Vaio, it took about 5
minutes to get to a Welcome
screen where I could choose
between trying Ubuntu 13.04
without making any changes to my
laptop or installing it. I chose to
completely overwrite my previous
install. After a few questions,
about 20 minutes and another
beer, I had a new version of
Ubuntu running on my old laptop.

That’s it. Seriously! I’ve had
farts that were more complicated

Time to test things out. I
restarted and found it took about
40 seconds to get to a login screen
and another 35 seconds to open a

browser window. That’s a net
savings of 10 seconds off my old
time, and makes me wonder how
much faster a newer version of
Lubuntu might be. It also makes
me wonder if I’ve become a nerd
who cares about ten-second
startup savings. Spoiler Alert: the
nerd ship sailed when I wrote a
strongly worded letter to the
Astronomical Union about Pluto’s
demotion.

Look, ten seconds might not
seem like a lot and, frankly, except
for people who have no impulse
control and need to check the
Reese Witherspoon mugshot on
TMZ, like, NOW, 10 seconds isn’t
much.

The real advantage is how fast
the Vaio runs now compared to the
previous install. The change was
noticeable from the moment I
clicked on Firefox and watched it
pop open with almost no
hesitation. LibreOffice did the
same. And running multiple
programs at once didn’t feel like
trying to pass a kidney stone.
Everything just felt snappier. It was
like waking from one of those
dreams where you’re trying to run
through molasses with a 300lb
naked zombie throwing Superman
Underoos at you. No? Not a shared
experience?

The point is, installing Ubuntu is
really, really simple these days. Any
simpler and Mark Shuttleworth

would have to come to your home
and personally do the install for
you. If you’ve got an older machine
you’ve been hoping to resurrect,
you might be surprised just how
speedy it can be without sacrificing
power. For a few million dollars (or
whatever the hell £5.04 converts
to), you can have the most up-to-
date operating system in
existence. For many of you, the
cost will be next to nothing.

Raring Ringtail is a good place
to start for anyone waiting to jump
into the Ubuntu end of the pool. I’ll
be there waiting for you, I’m the
one with the chartreuse floaties
and the Vitamin D deficiency. Yeah,
um, Tony Stark couldn’t make it but
he sends his regards. He did send
Jarvis, though. No, Jarvis, you can’t
get in the pool, you’re still plugged
into the--No, STOP, you’re going
to--BZZT!

ASK THE NEW GUY

http://yaconfidential.blogspot.com
https://help.ubuntu.com/community/BootFromCD
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When family or friends come
to visit, we usually end up

taking a lot of pictures. We could
share those pictures on social
networking sites or dump them on
a private ftp server, but, as
shocking as it sounds, not
everyone in our family has a
permanent Internet connection. To
solve this problem we needed to
come up with a little imaginative
thinking, the solution: imagination.

Imagination is an easy-to-use
DVD slideshow creator based on
GTK+2 libraries. It’s lightweight,

requiring only a few small files,
and, best of all, very easy to use.
Imagination is available in the
Ubuntu Universe repositories so a
simple sudo apt-get install
imagination is all you need to get
started.

When you first create a new
project with imagination, you’ll be
prompted to choose the video
format, size and background color.
Current versions of imagination
have four choices VOB (DVD
video), OGV (Theora vorbis video),
FLV (Flash video), and 3GP for

mobile phones. We like to send
family and friends home with a
DVD, so we chose to export to
VOB format. There are also four
size choices to choose from
720x480 NTSC, 720x576 PAL,
1280x720 HD and 1920x1080 HD.
Choose the size that best suits
your region of the world.

Adding photographs is a simple
matter of either selecting
Slideshow > Import Pictures from
the menu, or clicking on the small
black picture frame icon from the
icon bar (just under the Slide menu
option). Use CTRL or SHIFT to
selectively identify the pictures to
import (or select all), and click
Open. Once you’ve added pictures,
reordering is a simple matter of
dragging the pictures at the
bottom of the interface so they’re
in the order you want them to be.

If you don’t like the orientation
of a slide, you can rotate the slide
by selecting the appropriate
button under the Slide menu
option. You can also add a blank
slide. Blank slides can be a solid
color or either a linear or radial

gradient. If you’re creating a
slideshow with multiple sections or
locations, it’s sometimes helpful to
insert a blank slide with some
information. To add text to the
slide, first click on the slide, then
click over in the Slide Text section
on the right-hand-side and enter
your text. Click the font choice to
bring up a dialog box that lets you
choose the font family, style and
size. Beside the font, there are a
couple of colors for the font
foreground and background.
Below this are some animation
settings so you can make the text
fade, slide or grow. The same text
options can be used on regular
photographic slides, but make sure
you don’t have all slides chosen or
the option appears greyed out.

This is a slide show, of course,
and a slide show wouldn’t be
complete without some kind of
between-frame animation. To
provide uniform transitions from
slide to slide, select all the slides
(choose one slide then hit
CTRL+A), and choose a Transition
type from the slide settings near
the top right of the interface
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(Crossfade is a nice effect).

A small icon of the transition is
displayed on each picture at the
bottom of the interface so you
know which slides have which
transitions. You might be tempted
to create a different transition for
each slide - don’t do it, looking at
multiple transitions is bad form.

All this concentration on
pictures and we haven’t even
added any audio yet. Before we do,
have a look at the Slideshow
length under the Slide settings on
the top left. Each slide’s display
time is adjustable, you could
display a picture longer for the
first and last slides if you wanted.
The length of the slideshow will
determine how long a song (or
songs) you’ll need. You can add
multiple songs.

To add music, click the black
frame with the music note in it, or
click Slideshow > Import Music
from the menu. To reorder the
music, click the Audio tab, the song
you want to reorder, and the move
file up or down arrows at the
bottom of the audio tab.
Remember to select enough music
to cover the entire slideshow. Take
into consideration the length of

the slideshow if you’re trying to hit
a particular point in a song.
Remember you can always adjust
slide length, but this can be tricky
since you don’t also want people to
get bored looking at the same
slide for too long.

At the top of the interface
there’s a play icon that lets you
preview the slideshow. In version
3.0-r1, the play option didn’t seem
to play our music, it only
transitioned through the slides,
however when we exported the
slideshow to VOB format, the
music played just fine.

One thing to note when saving

the VOB file: be sure to add the
.vob extension, imagination
doesn’t seem to do this by default.
After exporting the VOB file, we
now need to get it to DVD. To
create the DVD we need to create
the DVD structure. First make a
dvd/ directory, mkdir dvd. Next
make sub-directories called
VIDEO_TS and AUDIO_TS, mkdir
dvd/VIDEO_TS dvd/AUDIO_TS
(note the space between
VIDEO_TS and dvd/AUDIO_TS).
Now copy the exported VOB file to
the dvd/VIDEO_TS and run the
mkisofs command to make an ISO
file that can be burned by k3b,
Brasero or XFburn:

mkisofs -dvd-video -o
mydvdname.iso dvd/

Where mydvdname.iso is the
name you want to give your ISO
file. The VOB file should be in your
dvd/VIDEO_TS directory or this
won’t work correctly. Now you’re
ready to burn multiple copies of
your slideshow movie.

Some people reviewing
imagination have mentioned that
this doesn’t give you fancy menus.
For that, programs like DeVeDe or
KMediaFactory (old) can help.

I’ve glossed over a few options
available in imagination, with a
little thought and toying it’s
possible to come up with some
amazing slideshows. There are
over 50 transitions, the ability to
overlay text and music, hold slides
for longer periods, and reorder any
slide. What you come up with is
really up to your imagination.

Charles is a step-father, husband,
and Linux fan, who hosts a not-for-
profit computer refurbishing
project. He maintains a blog at:
http://www.charlesmccolm.com/

http://www.charlesmccolm.com/
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The Ubuntu saga continues. Yes,
it is a saga with new twists and

turns every now and then, many
unexpected and unknown, but
then Linux was never planned in
the first place.

I bumped into Ubuntu in late
2007 when I bought a local
magazine called CHIP about
computing here in India. The
magazine had a CD of Ubuntu's
latest release at that time, with
the CD in the sealed cover. Also
the editor ran a story about how to
use it, and also shared the
experiences the staff had after
using it. I tried it off the CD boot
and was impressed. I then placed a
request for a free CD & DVD of
Ubuntu, Kubuntu and Edubuntu to
try all, since the shipping was free
and there were no hassles. I got
the Disks in 2 weeks time and I ran
all the versions. I was impressed
and amazed at how open source
worked and what a huge
contribution was made resulting in
a new OS.

Some months passed and I kept
playing with Ubuntu, and then, one

day, the nightmare of Windows
Users arrived. In simple words, my
PC crashed. The PC which
contained my whole family's data
crashed, sending shivers and
tension across my house (well, that
was 80GB+ of data of more than 4
users, to say the least). I was first
shocked and tense as how to get
back the data, since recovery
options are money matters here,
and very few know how to recover
the data from a damaged Windows
disk. But then Ubuntu came to the
rescue. All I did was boot the CD
from the CD drive, and run a Live
session, and copied the data onto
another disk borrowed from a
friend on which there was enough
disk space.

The next thing I did was coax my
family to start using Ubuntu and
replace Windows. First there were
raised eyebrows, questions asked
(which were answered thanks to
the community since even I did not
know much then), approvals were
rejected, but then finally everyone
agreed. I gave them the word that
data would not be lost and/or
hampered; the only thing that

would change was the OS. Then
every user was provided some
basic knowledge along with user
specific application training.

Thus Ubuntu 8.04 (Hardy Heron)
was installed in 2008 and my PC
was now alive and rocking with the
new OS. Updates came in from
time to time but these were to be
monitored since unlimited plans
for broadband were still too pricey,
and we were still using limited
broadband data plans. A year
passed and things changed. New
versions of Ubuntu released,
updates created some mess since
new updates would either cause
some old function not to work or
had to be tweaked, but the
community support kept flowing in
(forums were helpful and so was
the documentation). Also in the
meantime the unlimited data plans
in India became affordable and I
switched to one. Now the system
was always fully updated, and no
user had any issues since now
everyone was habituated to
Ubuntu and would do their own
customising.

Then came 2011, when mobility
became a factor for computing.
This year saw India shifting
towards mobile devices, and so did
my family. Now emails, social
networking and consumption
activities were done right from the
cell phones since data connectivity
across the country along with
smartphones, esp Android phones,
provided a good option to be
connected 24x7. This period saw a
decline in PC usage. One thing
never changed which was the
creation of content. It was still
done on the PC since on mobile
devices it was a cumbersome task –
though typing is possible, but
presentation & excels are still good
on a computer. Ubuntu, too,
changed a bit in this period. My PC
still ran Hardy Heron and I did not
upgrade it to the new LTS. Since
the PC usage had declined, the PC
was not used much, though the
data was still stored on it.

June 2011. On a fine Sunday
morning I switched on my PC and a
new bolt fell. No, Ubuntu did not
crash, but the hardware did. My PC
went into a coma with multiple

Written by Danish Lala
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component failures. I had to
replace the Motherboard, power
supply and the RAM. The Hard Disk
was still intact. I now started
looking for options but could not
reach a single decision about what
to do. Moving data of the whole
family to the cloud would mean
some good amount of spending. I
suggested that data be backed up
on multiple devices and each user
should take care of his/her own
data. This was promptly accepted
by all, and each user did take a
backup of the data. Months passed
and I too was unable to arrive at a
good solution. Since laptops had
the backed up data, and mobile
devices were used on a larger
context, the family was not
disturbed as had happened in
2008. But still I had to find a
solution for backups since even
Laptops are prone to crashes – be
it in terms of software or
hardware.

A viable and logical solution
that came to my mind was storing
data on an external hard drive. All I
did was buy a portable hard disk
and transfer the data to it. But
then if I just did that there was an
imminent risk of virus and trojans.
Hence, I decided to install Ubuntu
on it. Yes I installed Ubuntu on my

new portable hard disk. Why
portable? The reasons are quite
good to make you do so. First,
since it’s Ubuntu, data is safe (at
least safer than Windows). Second,
when the system is on a portable
disk, you can carry it anywhere (the
hard disk is hardly bigger than your
palm size). Third, you have
everything in one place (if you
work on multiple machines,
transferring data is a task). Fourth,
almost all PCs & laptops support
the USB HDD boot so no worries of
any hardware boot issue (I did
come across some PCs whose BIOS
had to be tweaked to activate US
HDD boot). Fifth, technology today
has improved to the extent that
these are more rugged and safe
and equivalent to internal hard
disks.

Now the install had to be done.
First step was to download the LTS
(I normally jump from one LTS to
another) of Ubuntu, so I
downloaded Ubuntu 12.04 (Precise
Pangolin). Before starting the
Install, I was clear about how many
and how big partitions I wanted.
Also I did refer to issue 15 of FCM
since it had an article to move your
Home partition to a separate
partition. After booting from the
CD, I clicked on the install shortcut

which is there on the desktop of
the live session. Since I wanted a
custom install, I chose the custom
options and made three partitions:
one was the root, second was
home partition, and the third was a
FAT32 partition for data which is
cross platform along with the swap
partition. The partitions were now
in place and I just followed the
steps which came when one
pressed the Next button. One
thing to remember is that while
the partitions are made, please be
sure of the sizes since their
extension and/or deletion and/or
creation is a risky task. Also I would
advise to keep the home partition
as a separate one since in case of
an upgrade via a fresh install, the
data will be safe. Also keep the
FAT32 or NTFS partition of
reasonable size since a large
partition may not be of much help
as the data copied might be moved
ultimately to your Home Folder.
Finishing the install I reboot the
device and voila! The system was
up and running. The next step was
obvious – get the data into my
Home sub-Folders and that is what
I did. I transferred all my data –
from documents to pictures to
audio and video files.
Simultaneously I ran the new
software manager Ubuntu

Software Manager for updates.
Since I was a bit uncomfortable
with it, I installed Update Manager
which was there in earlier versions.
This was installed – with some
more programs which are not in
the standard install – and then
updated. Customisations were
made and the system was ready
for use.

As of this date, the system is
working fine (in fact I am writing
this article on it). My data and work
is safe. Also I am trying to coax
people to try my new strategy of
keeping data on a portable device
running Ubuntu. Hope my
experience shared here will be of
use to you all. Till the next twist
and turn, keep rocking!
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If you want to do something, use
a PC. If you want to get

something done, use a Mac. Those
were the very words I spoke about
8 years ago when I mastered the
art of working with my very first
Apple computer. The simplicity,
elegance and productivity of the
Cupertino experience had me
convinced that the core business
of Windows computers was not
getting things done for you, but
running spyware and participating
in botnets to ‘get things done' for
some dingy hacker in his mother’s
basement in the southwest of the
Ukraine.

And in many ways my statement
was correct. I had been lured into
the Cupertinian crack the same
way a lot of people got into Apple:
I got an iPod, after the iPod came
the first iBook, then the first Mac
Mini, and so on. These days my
house consists mostly of hardware
that bears the seal of Newton's
falling fruit... Yet I start to wonder
... is that still something that is
absolutely necessary?

To answer this question, let us

look back to the state of the
technological landscape back in
those times. Apple had just
released "Tiger," bringing some
sense of stability and usability to
the fairly new tenth iteration of its
operating system. Where OS 1
to 9 still leaned heavily
on its Xerox roots,
OSX stood on
the shoulders
of a Unix
kernel and
offered a
clean but
fairly
customis
able
interface.
Windows
had just
delivered its
long overdue
baby called Vista,
and, even though
many people in the
industry considered it to be a
miscarriage, decided to release its
fledgling to the world.

The Linux wars were still raging
in full force as different factions in

the Debian and Red Hat camps
fought in a pyroclastic flame war in
the Newsgroups, incinerating each
other’s arguments and scorching
any newbie who dared to come
close with a novice question.

In that landscape,
Apple was truly a

shining beacon
of

productivity
with its Iife
and
iWords
suite, its
slick
hardware
and

elegant
operating

system, its
fancy MP3

player and its
endorsement by the

graphic and intellectual
society that "this was the way to
go". ... But today it is perhaps a
different story.

The one thing that has
dramatically changed is Apple's

focus. To me, the first sign was its
infatuation with the iPhone and
the mobile market. Probably
considered Apple’s most popular
and profitable product of all time,
the iPhone also changed the very
DNA of its maker. Apple used to be
about creativity, and I emphasize
'Create'. Want to write a novel? Get
a Mac. Want to get into graphic
design? Get a Mac. Want to call
your mom or play a game where
you throw birds at blocks? Sorry,
WHAT?

Indeed. Back then the core
focus of Apple was not aimed
towards entertainment or
communication, at least not until
the iPhone came along. And in
those years since Steve Jobs
picked that 'Magical" device from
his pocket, Apple has changed
considerably. As I looked around
the workspaces of my friends who
did graphic design, I saw their
Apple workstations age with time.
The near orgasmic cries of joys –
that they uttered whenever an
update was released – diminished
with every iteration and turned
into small grunts of frustration as

Written by Knightwise
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Full Circle Podcast
Episode 34,
Raspberry
Jamboree 2013

Your hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
and Freaky Clown

from the Blackpool (UK) LUG
http://blackpool.lug.org.uk

Welcome to the first of a 2
part conference special, in
this episode the presenters
reflect on the first ever
Raspberry Jamboree held at
the Manchester Central
Conference Centre on 9th
March 2013

Knightwise is a blogger, and
producer of the Knightwise.com
podcast. His website offers hacks,
tips and tweaks for cross-platform
geeks. Knightwisemoves with ease
across Linux, OSX, Windows, OIS,
Android and more.

MY OPINION
the upgrades to their shiny silver
towers were once again
postponed.

But for the rest of us grunts,
Apple still had something to offer:
superior hardware and a powerful
operating system. But the decay of
the latter started to show its
flatulent underbelly with the
arrival of Snow Leopard. In the
spirit of "IOS-i-fying" the operating
system, certain power features got
'hidden away" in favor of some 'IOS
like' enhancements that were
supposed to bridge both operating
systems. In essence, OSX was
getting dumbed down.

Oh well, If you are a slider, and
don't like a certain kind of
operating system, you just dual-
boot a second operating system
onto Apple's superior hardware ...
right? As long as that hardware
remains superior, there is no
problem, but, aside from the fact
that Apple's "innovation curve" on
its desktop and laptop platforms
was becoming an exceedingly
flatter slope, its prices continued
to keep the same high standards.
As the competition (Samsung,
Acer, Asus) caught up with equally
fancy ultrabooks (with an equally
fancy price), Apple decided it

would be a good idea to remove all
of the removable parts from its
hardware. The new iMacs got
glued shut, the Macbook Pro's had
no user replaceable parts .. The
(power) user started to lose the
one thing he had over his Apple
experience: control.

So do I still buy the Cupertino
party line when I'm out shopping
for a new computer? I used to say
'of course,' but that is starting to
change. Advising a friend (aspiring
power user) on a new laptop
yesterday, I heard myself utter the
words "Asus" and "Linux" in one
sentence. The request that queried
this answer was one motivated by
the option of "control". Being able
to "do" stuff with hardware you
can "do" stuff with. As many
flavors of Linux start to mature,
"Apple" is not the default answer
anymore, not even for the creative
minds! And if you are on a budget
and would like to add your own
sticks of RAM (or an SSD drive), the
polished silver of Cupertino is also
no longer the default solution.

What it comes down to is that
there are no certainties in the
computer industry. With the ever
faster pace of digital evolution,
today’s masters of the industry

become tomorrow’s outcasts --
where the outcasts become the
underdogs and the underdogs
become the new heroes. In a
couple of years, I've seen
companies and technologies fade
to the background, step back up to
the plate, and be embraced or
rejected by the ever growing
crowd of consumers. In the end
Apple has not lost its shine but it is
no longer the company it was
when it crawled out of the
shadows of oblivion. It is no longer
the underdog, nor is it the
prettiest girl at the ball. Microsoft
is no longer the corporate suit, and
Linux seems to have trimmed its
wildest beard. Everybody loses
some shine, and everybody gains
some. The great thing about this is
that there are no longer default
answers to standard questions.
And as the defaults subside, the
power of choice arises.

http://blackpool.lug.org.uk
http://fullcirclemagazine.org
mailto:support@penguincsc.co.il
http://Knightwise.com
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Written by Ronnie Tucker

TTVV BBrroowwsseerr

Having used this software
nearly every day since I

started using Ubuntu 11.10, I
would have rated it 5 stars in the
Software Centre, but this is not
possible as it is not in the Software
Centre and I downloaded it myself.

The latest version can be
downloaded for free from:
http://tvbrowser.org/, and comes
in a .deb version which can be
opened and installed easily using
the Ubuntu software centre, or, if
you are using a Debian based
distribution, the software package
manager. It is platform
independent but does depend on
Java or similar, so I guess that may
put some folk off. It is open source
and contains no advertisements
unlike most web-based TV guides.

WHAT IS IT?

The site tells you all about it,
but, as its name suggests, TV
Browser is a digital TV guide which
you can customize with your
favourite channels. It offers
various plugins. These can add
various options like e-mail,

calendar reminders, or Internet
Movie Database (IMDB) ratings,
and it can also, I believe, work with
TV cards as an EPG and scheduler.

WHO DEVELOPS IT?

It appears to be German based,
although it is possible to download
TV listings from around the
world—I use TV listings from the
Radio Times in the UK, for

example, but check the site for
your particular location. The
current authors as listed on the
website are as follows:
RenéMach (Release-Manager,

Developer)

MichaelKeppleraka. Bananeweizen

(Developer)

Björn Balazs (Usability-Consultant)

Nelson Darkwah Oppong (Grafic

artist)

KlausBlessing (Beta-Tester)

SUMMARY AND

CONCLUSION.

TV Guide is a useful piece of
software to plan your TV viewing
and help ensure that you don't
miss or forget to record your
favourites – thanks to its
reminders, favorites, and search
functions. It is also highly
customizable to suit your tastes in
viewing, and could also help you if
you are using your PC as a media
centre which records TV. I would
rate it as five stars if I could, but, as
I mentioned, I am unable to do so
in the Ubuntu Software Centre,
hence this much-overdue
review—Happy viewing.

http://www.htc.com/www/smartphones/htc-one-s/#specs
http://nostarch.com/gimp
http://tvbrowser.org/
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Written by John Niendorf

I've been using Ubuntu for a few
years and, thanks in part to

Lucas' column Command and
Conquer, I've become a fan of the
command line.

A couple of months ago, I
decided to try to find a good
console-based music program.
Rhythmbox comes installed on
Ubuntu 12.04 and it is a fine
program. It reminds me a lot of
iTunes, unfortunately I really don't
like iTunes. It just feels so big and
bloated. I don't really care about
seeing the album covers of my
music collection. I wanted
something that is small, fast, and
yet still easy to use. This is for
playing music after all, it should be
enjoyable, not a chore.

A Google search took me to a
post somewhere about cmus. It
sounded like just what I was
looking for. I checked the Ubuntu
repository and there it was, cmus
version 2.4.3, as well as the cmus
ffmpeg-plugin 2.4.3. “That was
easy!” I thought as the program
installed.

After I installed the program, I
had to add music to the library.
This is easy enough. Simply type a
for add and then specify the path
to your music collection. Cmus will
then scan the target directory and
add everything in that directory. As
you can see from the screenshot, it
picks up the artist, album and track
names, the year the song was
recorded/produced, and the length
of the song.

You can use the arrow keys to
scroll through the list of artists. If
you hit the space-bar, an artist's
entry will expand to show a list of
albums by that artist. When you
highlight an album, the tracks on
that album appear in the main
window. Pressing the tab key will
move you over to the main window
where you can scroll through the

list of tracks. Pressing enter will
start a track.

Pressing c will pause a track.
Pressing q will give you the option
of quitting cmus by pressing y or n.
Pressing p will add a track to the
playlist while e adds a track to the
queue. I usually just select an
album and press enter to start the
first song. The rest of the songs on
the album are played in sequence.

Typing / will allow you to search
for an artist, album or song. The [ ]
keys increase the volume and the {
} keys decrease the volume. Typing
cmus –plugins in the terminal will
bring up a list of all the different
types of files cmus should be able
to play. The list is quite long and
the most common formats are on
the list (.aac, .mp3, flac, wma). I

said should, because, even though
ffmpeg is shown in my list of
plugins and below ffmpeg .wma is
written as a supported format, I
cannot play the few Windows
Media Audio files I have in cmus. A
Google search did reveal that a bug
report has been filed about this
problem.

I usually use the default view
that appears when the program
launches. The number keys one
through seven will cycle through
different views. One takes you to
the default layout. Two brings up a
listing of every song in your library.

Three and four open the playlist
and queue views respectively,
while five opens the file browser.
Pressing the number six shows a
list of library filters, and pressing
seven shows all of the settings and
keybindings for cmus.

All in all, I am very happy with
the program. It does what I want, is
quick, lightweight, and was simple
to set up.

CCMMUUSS MMuussiicc PPllaayyeerr



full circle magazine #73 42 contents ^

LLEETTTTEERRSS
If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

SOLYDXK

I received a Full Circle preview of
the upcoming issue. Having

never seen SolydXK, I gave it a try.

I tried the LMDE conversion
script, which failed for me, I had
Mate edition with Package
Manager installed "KDE Full" and
thought it could go. Thanks to
backups, no problem. I ended up
installing SolydXK KDE. For my old
Dell D600 laptop, it is getting hard
to find a distribution that will run
on a Pentium M. It runs and runs
well. I had a very smooth install,
and it will do PAE and non-PAE as
needed, apparently. Very polished
for a new distro.

My biggest surprise was when I
clicked the add printer icon under
"System Settings". The usual
options appeared in the left
column, to my surprise the wireless
printer, a Brother HL-3075, was at
the top of the list. I clicked it and
kept hitting the next button and all
looked good. I clicked "print test
page" and was prepared to
manually edit the address.

The printer worked first time
and I am surprised. Linux is all I
use, and that printer has been very
easy to get going, well, except in
Windows 7 – which takes a long
time and required a USB
connection. No Linux PC ever did,
but most required additional setup
tweaks.

I recommend this distribution
to anyone who needs support for
an older processor like the
Pentium M. By the way, all desktop
eye candy, even "wobbly windows"
work just fine. Great job SolydXK
team!

Mike Lewis

MEDIA SERVER

I would like to see an article on
how to setup a media server

with Ubuntu to stream media to
the other computers on the
network and android phone.

Jorge Martinez

Ronnie says: ifthere’s anyone out

therewith the knowledge ofhowto

create such amedia server, please

sendyourarticle to

ronnie@fullcirclemagazine.org.

Gord notes: see theQ&A in this
issue.

WHAT, NO LINK?

How come the email sent out
to subscribers about issue 72

has no link to your website (that I
could find)? There are two links to
other websites, why not yours? In
order to download issue 72 from
your website, I had to start up my
browser, use Goggle to learn your
website address, and finally go to
your page with the current issue.
Or would you rather subscribers
use the link in your message to
issuu.com/fullcirclemagazine
instead??

Lou

Ronnie says: Surely I'm allowedone

slip-up in sixyears?

Join us on:

facebook.com/fullcircle
magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

goo.gl/FRTMl

FULL CIRCLE NEEDS YOU!

Without reader input
Full Circle would be an

empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

See page 25 to read our basic
guidelines. Follow those and
you're almost guaranteed
success.

Have a look at the last page (of
any issue) to get the details of
where to send your
contributions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
mailto:ronnie@fullcirclemagazine.org
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LETTERS
LIBREOFFICE SPECIAL

EDITIONS

I thoroughly enjoyed the
LibreOffice Special Edition Vol.1

(Parts 1-7 from FCM#46 -
FCM#52).

I appreciate your service of
providing the whole world with the
opportunity of reading FullCircle
for free, and would also like to
thank Elmer Perry for his efforts.

Please can we have more of this
useful content for both LibreOffice
as well as Ubuntu?

Paul

Ronnie says: Yes, therewill bemore
special editions in the coming

months. Robin (who creates the

special edition PDF's) has already

createdLibreOfficeVol.3 andwill

shortlybe creating several other

volumes, so keep an eye on the FCM

site formore.

FOR BEGINNERS

I'm a 64 yr-old who has decided
to leave Microsoft Windows and

I came upon a Linux article in the
August issue of Maximum PC
magazine.

In Sept. I downloaded Ubuntu
12.04LTS; it sat on my desk until 3
weeks ago when I installed it. In
the software Center I found a
listing for the Second Edition Users
Manual and found a link to your
Magazine which I have been
reading.

My question is would it be
possible for you or possibly
someone else to write a 1 or 2
page spread just for us beginners,
telling us in plain english how to do
updates, move around the file
system, and to download certain
programs?

LT Day

Ronnie says: anytakers forthis
article idea?In themeantime, I’d

pointbeginners to the Closing

Windows series that ran in several

issues ofFCM; it showedWindows

userswhere to findthings in various

Ubuntu flavors anddiscussed

updates andapplications.

SSUURRVVEEYY RREESSUULLTTSS
I’d like to thank everyone who took the time to fill in the survey from last
month. While I can’t guarantee we’ll cover everything you suggested, I
hope the results will give you, the readers, some ideas on what to write
about for future issues.

Results are taken from 959 responses.

GENDER:

AGE:
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SURVEY RESULTS

WHERE DO YOU LIVE?:
TOP 5 Italy 51 5%
United States 256 27% India 44 4%
United Kingdom 70 7% Australia 41 4%

HOW DID YOU FIND OUT ABOUT FULL CIRCLE?:

HOW LONG HAVE YOU BEEN READING FULL CIRCLE?:

WHICH OPERATING SYSTEM(S) DO YOU USE?:
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SURVEY RESULTS

IF YOU USE A *BUNTU FLAVOR, WHICH ONE(S)?: WHICH DESKTOP ENVIRONMENTS DO YOU USE?:

WHAT DO YOU USE LINUX FOR?:
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SURVEY RESULTS

WHICH ENGLISH EDITIONS DO YOU READ?:

WHAT DID YOU THINK OF THE FCM AUDIO EDITION?:

1 = Didn't Listen
.
5 = Loved It!

DO YOU FOLLOW FULL CIRCLE ON SOCIAL MEDIA?:

SECTIONS
EDITORIAL UBUNTU NEWS

COMMAND & CONQUER HOWTO - PYTHON

HOWTO - LIBREOFFICE GRAPHICS - BLENDER

GRAPHICS - INKSCAPE WEBDEV
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SURVEY RESULTS
SECTIONS
ASK THE NEW GUY LINUX LABS

MY STORY MY OPINION

REVIEW LETTERS

Q&A UBUNTU WOMEN

SECTIONS
MY DESKTOP DO YOU DO THE PUZZLES?

1 = No
.
5 = Always

MORE OR LESS?
GRAPHICS MUSIC

OFFICE GAMES

INTERNET DEVELOPMENT

VIDEO COMMAND LINE
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SURVEY RESULTS

CUSTOMIZING THE DESKTOP

COMMAND & CONQUER
WHICH TYPES OF ARTICLES DO YOU FIND MOST HELPFUL?

UBUNTU GAMES
WHAT WOULD YOU LIKE TO SEE MORE OF?

YOUR SUGGESTIONS FOR ARTICLES
If you’re interested in picking up one of these ideas, please read the
submission guidelines first, then email your article to
ronnie@fullcirclemagazine.org.

Hot questions from AskUbuntu

Other Distro. Even though FCM is
about Ubuntu, other distros
deserve your attention

Alternative desktop environments.
Maybe some Niche' environments

like Amateur Radio, Science,
Photography.

Any ubuntu based distro review
would be great, cover some
advanced kernel aspects (or kernel
updates).

mailto:ronnie@fullcirclemagazine.org


full circle magazine #73 49 contents ^

SURVEY RESULTS
Installing alternate/non-standard
desktop environments.

I would love to see a section on
Ubuntu Server Admin.

Would be nice to have a step-by-
step basic ubuntu server
administration for those who do
not have experience with
command-line.

UDS related details, and in-depth
details of important decisions
made by community that affect
Ubuntu.

Troubleshooting, System & Data
Recovery, Testing.

Dual boot, especially with Win7/8
and UEFI

I'd like to see articles about how
open source changes the way we
do business. So, not only the
technical aspects of open source,
but also what it means for (small)
business owners (by example).

Amateur Radio programs.

How-to on Linux From Scratch.

Wine - running Windows programs
on Linux (particular interest
simulation games). I'd love to dump
Windows completely.

Home media center related
programs.

How to set up ubuntu server for
low power always-on backup and
plex server. graphic interface.

How to deal with internet privacy
in a world of government and corp
intrusion.

Interoperability with windows.
Most of us have a windows pc.

More about backup strategies and
programs to use, particularly for
the home user.

Explain terms such as the kernel
(updates on updates), memory,
SSD, and such.

Hardware "how to do articles"
cameras, old gear, new gear,
printers, scanners, graphics
tablets, etc.

How to make Linux computers
more useful on home networks,
media servers, NAS.

Short pieces on specific instances
of who is using Linux in the world,
and how... Example: How does
NASA use Linux, How is it use in
robotic factories?

How-to on using ipods without
iTunes.

Making Netflix run under Linux at
speeds that work.

Customizing your own distro, more
on scientific/productivity apps ( for
example mindmapping, Zotero).

Would really like to see stories of
how people use Linux around their
house to help them through the
day. Home automation, having
linux update calendar/schedule
displays throughout the house.
Memory prompting for my Mom
who has Alzheimers, voice
recognition and voice response.

Anything doing with adding PPAs
for new programs.

I can't guarantee we'll cover all these subjects. As I always say: we can
only publish what you, the readers, send us. So, if there's anything
in those suggestions you'd like to pick up, drop me an email. Let me
know whether you want to write something as a one-off article,
whether it'll be a series, or whether you want to pick up the idea as a
monthly column.
Remember: anyone can write for Full Circle.
Thanks!
Ronnie
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QQ&&AA
Compiled by Gord Campbell

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org, and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Q In FCM#37, you talked about
helping a new user. However,

the Ubuntu Forums have changed.
What is the new procedure?

A Open the Ubuntu Forums.
Click on "Activity Page." Click

on "New Posts." On the right, near
the top, it will show "1 2 3 4," click
on 4, then click on 7, then click on
10. Look for messages with
"Replies: 0".

Some of the people have not
provided enough information, ask
them for more. Some of them are
"English as a second language," ask
for clarification. Some are asking
questions which were solved eons
ago, Google them a link. And some
have complex questions about rare
hardware/software combinations,
ask them a question which will
keep the conversation moving.

It's even possible that you will
see a question which you can
answer, and that's the best feeling
of all!

Q I've heard a new term,
"restricted boot," but I don't

understand it.

A Here's a nice writeup by
Matthew Garrett:

http://mjg59.dreamwidth.org/238
17.html

Q I have just upgraded two
computers to Xubuntu 13.04.

Now the External USB drive
connected to the Modem/Router
cannot be mounted.

A (Thanks to Alan.Brown in the
Ubuntu Forums) This is due to

the new kernel version. Add the
option sec=ntlm in the fstab entry.
To mount it manually in my case:

sudo mount -t cifs -o
sec=ntlm,uid=1000,gid=1000,gu
est,_netdev //192.168.0.1/USB
/home/user/USB

Q How can I get an in-depth
understanding of Linux?

A Install Linux From Scratch on
a spare machine.

http://www.linuxfromscratch.org

Don't expect a working system
in the first week.

Q I want to set up a media
server, but I don't know where

to begin.

A Linux Magazine had a recent
article which might help:

http://www.linux-
magazine.com/Online/Blogs/Produ
ctivity-Sauce/Set-up-a-DLNA-
Server-in-a-Minute

Q Every time I eject a device
(CD, Zip disk, flash drive,

whatever), I get this message and I
have to click OK on it: "The device
"ZIP100" is being ejected. This may
take some time." I use Xubuntu
12.10. How can I get it to stop
doing this? It's unnecessary and
annoying.

A (Thanks to LewisTM in the
Ubuntu Forums) You should

try to remove notify-osd, and
install xfce4-notifyd, then reboot.

To configure the Xfce notification
daemon, run xfce4-notifyd-config.

Q I'm trying to write a script
that would loop through the

files of a directory and add the
names of each file to a text file.

A (Thanks to r-senior in the
Ubuntu Forums) You don't

need a script, just use this
command:

ls -1 > files.txt

Q Let me first give you my NAS
setup:

Ubuntu 12.10 on a single system
drive, RAID5 setup over 5 hard
drives for data.

If my system drive fails, is it
possible to reinstall Ubuntu and
have the NAS (i.e. the RAID5 array)
back up and running with hopefully
all data intact?

A (Thanks to rubylaser in the
Ubuntu Forums) On my home

server (media server), since the
base OS doesn't change much, I

mailto:questions@fullcirclemagazine.org
http://mjg59.dreamwidth.org/23817.html
http://www.linuxfromscratch.org
http://www.linux-magazine.com/Online/Blogs/Productivity-Sauce/Set-up-a-DLNA-Server-in-a-Minute
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Q & A
occasionally dd the OS disk to a
backup disk. That way, if the hard
drive dies, I throw the new disk in,
turn the computer on, and I'm right
back where I was previously. (Gord
notes: dd copies things. See
http://www.howtogeek.com/howt
o/19141/clone-a-hard-drive-using-
an-ubuntu-live-cd/)

Q I do not know how to use my
android mobile's internet on

my laptop, through USB.

A (Thanks to 3dmatrix in the
Ubuntu Forums) I just needed

to check USB tethering ON in my
phone.

Q When I go to a site which has
Flash videos, I get a message

about having an old version of
Flash installed.

A In your favorite software
installer, search for

"flashplugin," and install it. (I have
seen adobe-flashplugin and
flashplugin-installer, they both
work.)

Q Skype doesn't work in Ubuntu
13.04.

A See this fix:
http://www.webupd8.org/201

3/04/fix-skype-not-working-in-
ubuntu-1304.html

Q A program I'm looking at says
I need Mono. When I searched

Synaptic for Mono about 50 entries
came up. Which one do I need?

A mono-runtime

Q Can I use the COBOL
programming language in

Ubuntu?

A Yes, install open-cobol.

Q I'm trying to compile a c++
program in Ubuntu. However I

am getting errors using "gcc
testcpp.cpp -x c++ -o test"

A (Thanks to steeldriver in the
Ubuntu Forums) To compile

C++ it's preferable to explicitly
invoke g++ rather than gcc: g++
testcpp.cpp -o test

Q I have a current generation
System76 Lemur Ultra. I have a

KomputerBay 128 GB 400X Class
10 UHS-1 SDXC card. I want to use
LUKS volume encryption. Adding
several gigabytes of new data to
the SDXC card results in
input/output errors.

A (Thanks to System76 support
staff) Our card readers don't

support 128 GB SDXC cards with
LUKS encryption. Going with a 64
GB card is better.

Q I wanted to change my
password, and used the

command:

sudo passwd

However, my password was not
changed.

A (Thanks to Cheesemill in the
Ubuntu Forums) By using

sudo, you have changed root's
password, which is usually
disabled, not your own. Use the
command: passwd

Q I want to change the login
screen background.

A (Thanks to
grahammechanical in the

Ubuntu Forums) Replace
usr/share/backgrounds/warty-
final-ubuntu.png.

TIPS AND TECHNIQUES
Upgrade time for some

By the time you read this, three
versions of Ubuntu have fallen

into the "not supported" bin: 8.04
Server, 10.04 Desktop and 11.10.

http://www.howtogeek.com/howto/19141/clone-a-hard-drive-using-an-ubuntu-live-cd/
http://www.webupd8.org/2013/04/fix-skype-not-working-in-ubuntu-1304.html
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After a long career in the computer
industry, including a stint as editor of
Computing Canada and Computer
Dealer News, Gord is now more-or-
less retired.

Q & A

Not only that, but there have
been changes to the duration of
support for new versions. As of
12.04, "Long Term Support" (LTS)
means five years of support.
Effective with 13.04, support for
"standard" releases has been
reduced to nine months. Makes
sense to me.

If you want to just get things
done, stick to an LTS release. After
two years and a few months, have
a look at the next LTS release and
decide whether you want to move
to it. Otherwise, you will need to
switch a few months after the
following LTS arrives, eg. 16.04. A
change every four years isn't very
disruptive.

If you want the latest shiny,
move to each new release shortly
after it appears.

I use an LTS, and I have the
latest release installed in
VirtualBox -- but that's just so I can
answer questions.

There's one factor which can
throw a spanner into the works:
you get a new computer, and it
works fine with the latest
"standard" release, not so much

with the most recent LTS. I ran into
this myself: the computer I am
writing this on was "fully
supported" by 10.10, but some
things didn't work in 10.04 LTS. I
also own a USB WiFi adapter which
was not supported before 11.04. It
just means you need frequent
switches until the next LTS arrives.

I'm still not a fan of upgrades.
When I install, I make separate root
and home partitions, then I do a
clean install for any new version.
So far, this has been problem-free.
One example: if you do a clean
install and the power goes off part-
way through, you just start over. If
you're doing an upgrade and the
power goes off, your system might
be unusable -- and maybe your
data is gone.

ZATO

A newly released project, Zato, is an Enterprise Service Bus
(ESB) and application server written in Python.

Out of the box Zato offers HTTP, JSON, SOAP, REST, Redis,
AMQP, JMS WebSphere MQ, ZeroMQ, FTP, SQL, hot-
deployment, job scheduling, statistics, and high-availability load
balancing.

There's a Django-based GUI, command line interface for
admins and a JSON/SOAP API for hackers wishing to built
alternative tools on top of services offered by Zato.

The 1.0 release comes with several hundred pages of
documentation and is available under LGPL at https://zato.io

Advertisement

https://zato.io
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UUBBUUNNTTUU GGAAMMEESS NNEEWWSS
Written by Dougn Redhammer

First off, if you haven’t heard
the sad news a few months

ago, LGP (Linux Gaming Publishers)
lost the rights to sell Egosoft's X
series of games (X2-The Threat
and X3-Reunion); the good news is
Egosoft is now actively developing
its games for Linux—so, if anyone
has purchased the X-series
superbundle or X3-Reunion on
Steam, you have access to the
Linux version as well. Work
continues on X-Beyond, X2 and X3-
Terran Conflict, but is not yet
available outside of closed beta.

Next up, Unigine has finally
released Oil Rush and its DLC on
Steam for Linux this week,
meaning if you purchased the
game directly from them, it’s now
available for installation via the
Steam for Linux client.

Now for the games that are
coming soon. Most come from
Steam's Project Greenlight and all
are from Indie Developer Studios.

First up is Starbound
(www.playstarbound.com) from
Chucklefish. This is a 2D

sidescroller in the vein of Terrarria
and Minecraft, except this time,
along with an open sandbox world,
you also get a single player
storyline. The game is available
now for pre-order, and those who
do pre-order get beta access. Read
more here
http://playstarbound.com/about/,

Next up we have Legends Of
Aethereus from Three Gates
Studios. This Action RPG was
successfully funded last year via
Kickstarter, has beta access for
Kickstarter backers, and has now
been Greenlit by the Steam
Community. See more here
http://www.aethereusgame.com/i
ndex.html. Finally, the developers
are now taking pre-orders for the
game.

Third on the list is
Hammerwatch from HipShot. In
the developer's own words about
the game:
"A hackandslash action adventure,

set in a fantasypixel art

environment. Solo orcooperate in

this adventure from bottom to top

ofCastle Hammerwatch. Kill hordes

ofenemieswith variedlooks and

features, through fourunique

environmentswith traps, hidden

secrets andpuzzles.

The game is inspiredbythe old

Gauntlet-series, butaddsa lotwith

online support, character

development, complex levels,

bosses, andmuch more. Like

gauntlet, the focus is fastpaced

action, butwith elements thatforce

you to think justa bitmore!"

A playable demo
(unfortunately, for the Windows
OS ) is available; another greenlit
steam game; find out more here
http://steamcommunity.com/share
dfiles/filedetails/?id=122788084

"LegendofDungeon is part

Beat'Em'Up, like those awesome

old-school 4-playerarcade games (it

plays a little like TMNTandX-Men),

andit's partRogueLike in its setting

andcontentgeneration."So states
the introduction for the next
Greenlit Game Legend of Dungeon
from developer RobotLovesKitty.
The game is set for a summer 2013
release, and is currently taking pre-
orders that grant access to a
playable version of the game. Read
more here
http://www.robotloveskitty.com/L
oD/ and here
http://steamcommunity.com/share
dfiles/filedetails/?id=108895757

And that’s it for games that are
projected for a 2013 summer
release date. There are several
other games on the horizon, but
their release dates are either early
next year or December 2013. So
nothing much to talk about since
the dates are so far out.

http://www.playstarbound.com
http://playstarbound.com/about/
http://www.aethereusgame.com/index.html
http://steamcommunity.com/sharedfiles/filedetails/?id=122788084
http://www.robotloveskitty.com/LoD/
http://steamcommunity.com/sharedfiles/filedetails/?id=108895757
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UUBBUUNNTTUU GGAAMMEESS
Written by Jonathan Bossenger

When the opportunity to try
out for the position of game

reviewer at FCM came up, I jumped
at it for three reasons. I am a huge
fan of the Ubuntu operating
system and its variants, I have had
a love for gaming since I was about
10 years old and typed ‘open door’
in my first Sierra adventure, and,
for a long time, I’ve been keen to
somehow capture my thoughts on
the topics of gaming and Ubuntu in
one place. The chance to actually
do this was too good to pass up.

But what game would I review?
FCM has been running for quite
some time now. Do I take an older
game, or find something new to
review? Fortunately the gaming
gods took pity on me, and, just
over a week ago, Valve announced
that they would be releasing their
2007 smash hit Portal on Steam for
Linux. I was too busy with other
FPS games at the time when Portal
was initially released (sigh, I’m
looking at you Call of Duty 4:
Modern Warfare), so this
presented the perfect chance to
complete and review a game that
was freshly released to the Ubuntu

world.

At this point I am ashamed to
admit that I missed out on the big
launch of Steam on Ubuntu. Due to
various factors in my life at the
time, I wasn’t involved in Ubuntu
gaming in any way over the course
of 2010/2012. My memories of
Ubuntu gaming were either open
source games developed by the
community, or porting Counter
Strike over to Ubuntu using Wine
for office lunch time frags. The
launch of Portal on Steam in
Ubuntu would be the perfect
opportunity to get back into
Ubuntu gaming and I grabbed it.

However, what I planned to be a
review of a great Valve game on a
different platform turned out to
be an exploration into the world of
gaming on Steam in Ubuntu. As
soon as I booted up my Ubuntu
partition on my gaming PC (with a
fresh install of 12.10) and
proceeded with the Steam
installation, I found myself finding
the process of installing Steam and
the actual implementation of it on
an Ubuntu system way more
interesting than the game itself.
Suddenly I found myself rewriting
my first article – from a review of a
game to a review of the gaming

delivery platform itself.

The first thing I found
interesting was how Steam is listed
in the Ubuntu software manager. I
know that the product is free to
download, but why the $0.00 price
tag? As I had not installed software
on Ubuntu for a few years, I
assumed this was just the usual
practice. I guess I just expected it
to say ‘Free’ or similar. What I did
find refreshing was that it was
available in the Software manager
and didn't require me to run any
terminal commands.

As a user of Steam on ‘that
other OS,’ I was pleased to find
myself on familiar ground once the
install had completed. The login
screen was an exact replica of
what I was used to. In fact, once I
was logged in, the actual client
itself was unchanged, even the
window buttons were the same,
which made things a little tricky, as
the default Ubuntu install I was
running was utilising the new Unity
interface which means other
windows’ buttons were on the
opposite side.

FFuullll SStteeaamm AAhheeaadd
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Jonathan is a developer and gamer
living in Cape Town, South Africa.
When not writing code, writing
articles or gaming, he spends time
with his wife and young son.

UBUNTU GAMES

Once I logged in I realised the
reason for this. Valve had merely
ported the Steam client directly to
Ubuntu, without making any major
changes to the interface (none at
all as far as I can see). Some small
part of me was hoping it would be
all shiny and new and specific to
Ubuntu, but I understand why this
is not the case. That doesn’t mean
to say I am happy about it...

I was interested to find out that
due to the direct port of the Steam
software, it meant that all the
games I had purchased via Steam
over the years where listed as part
of my library on Ubuntu. Obviously
all these games weren’t going to
run (I’m too scared to try in case
something explodes), but it would
have been nice if Valve had made it
so that Steam detects what OS you
are running on and then filters the
games you can play. As it is, I had
to select ‘Linux Games’ from the
‘Library’ menu before I could filter
the games I was actually going to
be able to play.

Sure enough, right there
between Half Life : Opposing Force
and Ricochet was the Portal (Beta)
game. It must be noted that I had
already purchased Portal

previously, and I was pleased to
see I wasn't going to have to
repurchase it to be able to play it
on Ubuntu.

At this point, after the Ubuntu
OS reinstall, installing the third
party graphics drivers for my
nVidia card, and installing and
logging into Steam, it was just too
late to start playing Portal on
Ubuntu with enough time to
complete the game and write a

review. So I poked around a bit
more to see what else I could find.
What I did come across is the fact
that there are, at the time of this
article, 180 Steam games that can
be installed and played on your
copy of Ubuntu.

I take this as a serious step in
the right direction. As a gamer I am
tired of having to own a copy of
Windows just to play my favourite
titles. I really, truly hope that Gabe

and the boys over at Valve are
successful in turning game
developers on to the idea of
selling/porting their products to
Linux through Steam. Part of me
wants to jump up and run to the
highest hilltop and scream and
shout for joy.

But for now, I have some Portal
to play.

Apparently there’s cake!
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Joseph is a Communications major at
Keystone College in La Plume, PA.
He's also the Director of Technology
for Gamers Against Bigotry. You can
follow Joe on twitter (@dogboi) and
find his blog at jejohaneman.com

UUBBUUNNTTUU GGAAMMEESS
Written by Joseph Johaneman

Strategy games are known for
their steep learning curves and

long play times. Aeon Command,
however, is a casual strategy game
that is easy to learn and fun to
play. It combines casual arcade
gaming with resource
management, research, and ship
production to produce an unique
gaming experience. The main goal
of the player is to defend his or her
mothership and to destroy the
enemy’s mothership.

There is a brief tutorial to teach
you how to manage resources.
From there one can either play in
campaign, skirmish or multiplayer
mode. Campaign mode unlocks
more ships, more technology, and
more abilities as you play through
each mission. There are three
factions: the Alliance, the Exiles
and the Cyborgs. Each faction has
its own ships and abilities. The
factions are fighting over the
resources contained in a
particularly resource-rich nebula.
In the beginning of campaign
mode, the player cannot do
research until given charge of the
fleet by defeating the current

commander.

As Campaign mode unfolds, the
player is given access to new
abilities such as an EMP, and the
ability to heal ships in combat.
These abilities depend on energy
taken from enemy ships, which
appears after they are destroyed.
A player needs to click on the
leftover energy before it
disappears, similar to bonuses in
arcade games.

In order to build ships and
conduct research, the player must
collect mineral resources from
asteroids. A player is allowed only
10 mining ships so resource
collection in later stages of the

game must be supplemented by
capturing enemy vessels with tow
ships. It is imperative to protect
tow ships as they bring back their
cargo. There are shield ships that
can project a field around tow
ships and other vessels to protect
them from enemy fire for a short
time.

The graphics in the game are
nothing special, but they get the
job done. It can sometimes be
difficult to tell which ships are of
which type, especially when
fighting the cyborgs. This a
problem, because in order to
adequately defend your
mothership, you need to know
which ships to build to engage

certain enemy vessels. The audio is
fitting to the genre, and of fairly
high quality. The sound effects are
traditional space battle sounds.
The music is neither repetitive nor
boring.

The game is currently $2.99 at
Desura. If you like strategy games,
or if you’d like an interesting casual
game, I highly recommend Aeon
Command, both for its value and
its playability. If you’re curious
about strategy games, Aeon
Command is a great and simple
introduction to the genre.

Pros: Low price, good sound, fun,
and easy to learn.
Cons: Graphics that make it
difficult to distinguish ship types.

AAeeoonn CCoommmmaanndd

http://jejohaneman.com
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LLIINNUUXX CCEERRTTIIFFIIEEDD
Written by Richard Philip Witt

Richard Philip Witt, 30, living in
Switzerland. I’ve been using Ubuntu
desktop and server for roughly 2
years. But only for the basics. Now I
want to discover its capabilities. Any
mentors out there? Email me:
chilledwinston2@hotmail.com.

ADDENDUM
To my horror, having proudly
informed you all of how to create
your first alias, I restarted my
computer only to notice that my
alias commands had disappeared. I
repeated the process: set the alias,
restarted the puter. Nothing. So:
how can an alias survive a restart?

.BASHRC
The .bashrc file is for user-

specific (just your account, not for
the whole computer) changes to
your terminal. Open .bashrc with
your favorite editor. (If I had been a
very good boy, I'd have made a
copy of it before editing). It's
located in your home directory.
Run a search for alias on the file
contents. You should, with a
minimal amount of searching,
come across something that looks
a bit like this:

...
# some more ls aliases
alias ll='ls -alF'
alias la='ls -A'
alias l='ls -CF'
...

If you remember from last

month, I wanted to change how
folders and files were listed when I
used ls. I wanted to: i) list files &
folders vertically; and ii) list
directories first. The more
observant of you will realise that
the aliases listed above determine
the functionality of ll, la & l not ls.
The ls alias is sitting above them
amidst some code. In my .bashrc
file, it looks like the code below.

...
# enable color support of ls
and also add handy aliases
if [ -x /usr/bin/dircolors ];
then
test -r ~/.dircolors && eval
"$(dircolors -b
~/.dircolors)" || eval
"$(dircolors -b)"

alias ls='ls --
color=auto'
...
fi
...

For Ubuntu 12.04 LTS, ls is
preset to list files and folders in
different colors. Hence, an alias
already exists for ls, as seen in the
code above. I merely need to add
my two preferences to the existing
alias.

...

alias ls='ls -1 --group-
directories-first --
color=auto'
...

Save the .bashrc file, restart the
computer, and the alias settings
remained. Problem solved.

SHOWING OFF
Following this small success, I

added two more aliases to make
my Ubuntu-ing a little quicker.

#firefox alias
alias firefox='firefox --
private &'

#evolution alias
alias evolution='evolution &'

Also, I often turn on my puter
and want to open both a browser
and my email, but not always. So I
added one more alias for this:

#open evolution & firefox
together
alias internet='evolution
firefox'

One important to thing to note
about this piece of code is the
missing && between evolution and
firefox, which would be necessary

if I were to run two commands
simultaneously at the command
line. However, one ampersand & as
set in the initial alias alias
evolution='evolution &' already
returns the command line when
the program has been launched so
it's not necessary to inform the
computer you are launching two
commands simultaneously with
&&.

To finish, please tell how you
use alias on your machine.

NB. The alias command & .bashrc is
a part of LPIC learning statement
1.105.1 Customize and use the
shell environment. (weight: 4)

mailto:chilledwinston2@hotmail.com
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MMYY DDEESSKKTTOOPP

I've been using Linux and open source for more than a year now
since I brought my laptop pre-installed with Ubuntu 10.10.
Upgraded it to Ubuntu 12.04. I loved all the enhancements in the
release and have been using it ever since.

I have a Dell Inspiron N4050 with Ubuntu 12.04.2 LTS installed. My
processor: Intel® Core™ i3-2330M CPU @ 2.20GHz × 2 - Graphics:
AMD Radeon HD 6400M Series - Memory: 2 GB

GTK Theme: Faience
Icon Theme: malys-uniblack
Cursor Theme: DMZ-Black
Window Theme: malys-futuree

Denz Alovera

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

I'm running Ubuntu 12.04 and make use of Conky and Quick
Lists quite a bit.

In the desktop shot, you can see: my To Do list, which is
powered by ToDo.txt, a really cool program that also has an
iPhone / Android app and uses Dropbox. Below that is my mail
conky which, thanks to DavMail, allows me to see new messages
on the Exchange server at work. I use Mutt for my personal
email, but Thunderbird for the Exchange stuff. Next is this
week's schedule pulled from Google calendar. At the bottom is
a calendar—not connected to Google calendar. Over on the
right is my weather conky.

John Niendorf

mailto:misc@fullcirclemagazine.org
http://www.gothicwalpapers.com
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MY DESKTOP

Hardware:
MB: MSI 945GCM5 V2
Processor: Dual-Core at 1.6 GHz
RAM: 2 GB
HDD: 160 GB
Graphics onboard
Software:
Linux distribution: Ubuntu 12.04 precise
Unity 3D and Conky
GTK Theme: Ambiance
Icon-Theme: fs-icons-ubuntu-mono-dark
Cursor Theme: DMZ-Black
Wallpaper: nastol.com.ua-10332.jpg

Yeinier Ferrás

Here's my desktop, stock Ubuntu 13.04 x64 with Unity
Tweak Tool used to create a Transparent Notification Bar
and a nice salamander wallpaper ready for when the 13.10
Repos go active. Running on a Toshiba Satellite C660-15R,
Intel Celeron 900 2.20GHZ CPU, 4GB of RAM with 3.7GB
available to the system and the rest used by integrated
Mobile Intel GM45 Express Graphics.

Roland Hurt
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HHOOWW TTOO CCOONNTTRRIIBBUUTTEE
Full Circle Team

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred

Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

FCM#74
Deadline:
Sunday 09th June 2013.
Release:
Friday 28th June 2013.

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and
you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full
circle', choose an issue, and click the download button.

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button
which is available on issues 51+.

Getting Full Circle Magazine:
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